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Just-in-Time Acceleration Builds: Quickly build the top-level model for
improved performance when running simulations in Accelerator mode

When you simulate a model in accelerator mode, Simulink® now uses Just-in-Time (JIT)
acceleration to speed up the building of the accelerator target for the top-level model.
Using JIT, Simulink generates an execution engine in memory instead of generating

C code or MEX files during simulation. JIT provides the best performance for the
generation of the accelerator target for a model.

For more information, see “Accelerator Mode”, or watch this video to learn more.

If you want to simulate your model using the classic, C-code generating, accelerator
mode, run the following command:

set_param(0, "GlobalUseClassicAccelMode®, "on%);
Dataset Signal Plot: View and analyze dataset signals directly from the
MATLAB command line

Use plot to plot dataset signals in the Signal Preview window for
Simulink.SimulationData.Dataset and Simulink.SimulationData.DatasetRef objects.

Watch this video to learn more.

Multi-State Image Dashboard Block: Display different images based on
the signal value

The Dashboard block library now includes a Multi-state Image block that you can use to
display changes in signal values. After adding the block to your model, double-click the
block and select signals whose states you want to capture visually. For each state, select
a value and an image to display. When the value of a signal changes, the block displays
the image that you set up for that particular value.

Simplified tasking mode setup

Previously, you set the tasking mode for your model using the Tasking mode for
periodic sample times drop-down in the Configuration Parameters dialog box.


http://www.mathworks.com/videos/just-in-time-acceleration-builds-120868.html
http://www.mathworks.com/videos/dataset-signal-plot-120866.html

Simulation Analysis and Performance

You were also able to set the tasking mode programmatically using the SolverMode
parameter.

In R2016b, a simple check box labeled Treat each discrete rate as a separate
task replaces the drop-down. The command-line equivalent of this parameter is
EnableMultiTasking.

Tasking mode for periodic Treat each discrete rate as a
sample times separate task
Command-line parameter |SolverMode EnableMultiTasking
Parameter values Auto, Multitasking On (enables multitasking
mode)
SingleTasking OFf (enables single-tasking
mode)

If you select the check box, single-tasking mode is used in these cases:

*  Your model contains one sample time.

*  Your model contains a continuous and a discrete sample time, and the fixed step size
is equal to the discrete sample time.

For more information, see “Treat each discrete rate as a separate task”.

Compatibility Considerations

By default, new models now have the single-tasking mode enabled, whereas they had the
Auto tasking mode enabled previously.

Further, if you have references to SolverMode in your scripts, replace those references
with EnableMultiTasking. Use the permissible values for EnableMultiTasking to
specify the tasking mode.

Diagnostic Suppressor: Suppress specific simulation warnings on
particular blocks
The Diagnostic Viewer in Simulink now includes an option to suppress certain

diagnostics. This feature enables you to suppress warnings for specific objects in your
model. Click the Suppress this warning button next to the warning in the Diagnostic
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Viewer to suppress the warning from the specified source. You can restore the warning
from the source by clicking Restore this warning.

Diagnostic Viewer EI@
E - % * 4 - ‘% - | i" - | oF - @J
myModel

+ Simulation @O 2

Saturation occcurred. This originated from ‘myModel/Data Type Conversion'.

‘'myModel /Data Type Conversionl'.

You can also control the suppressions from the command line. For more information, see
“Suppress Diagnostic Messages Programmatically”.

Diagnostic Viewer: Improved build diagnostics display

Diagnostic Viewer detects compiler errors and warnings generated during model build
and reports them with the ability to navigate to the source of the problem.
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Simulink Editor

Property Inspector: Edit parameters and properties of model elements
using a single interface

The Simulink Editor enables you to use a single interface to edit parameters and
properties for any model element. When you display the Property Inspector, it becomes
part of the model editing window. Select View > Property Inspector to open this
interface. You can leave the Property Inspector open as you build your model, and

it updates with your selection. To learn more about setting properties, see “Setting
Properties and Parameters”, or watch this video to learn more.

You can use the Property Inspector to edit:

* Block parameters and properties

Stateflow” elements

+ Annotations, areas, and images
+ Signals

*  Model properties

Edit-Time Checking: Detect and fix potential issues in your model at
design time

The Errors and Warnings option enables edit-time checking, providing you with visual
cues about issues with your model. To display information about an issue, hover the
cursor over the highlighted block and click the error or warning icon.

Simulink detects the following block errors and warnings:

*  Goto and From block mismatches.

+ Duplicate data store blocks. The value of the Duplicate data store names parameter
determines if there is a visual cue, and if the cue is an error or warning.

The Errors and Warnings option, is enabled by default. To turn off this option, in the
model window, select Display > Errors & Warnings.

For more information, see “Model Design Error Detection”.
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Finder: Search for model elements using improved interface

The interface for searching by way of Edit > Find (Ctrl+F) is improved in R2016b. To
learn how to search using this interface, see “Find Model Elements in Simulink Models”.
Annotations in Libraries: Add annotations from libraries into models

In R2016b, you can add annotations to custom libraries for the user of the library to add
to their model. To learn how to add an annotation to a library that appears in the Library
Browser, see “Create a Custom Library”. Add annotations to your model from a library
using the same techniques you use for adding blocks.

Library Browser: Expand or collapse libraries by default

You can customize the display of any library in the Library Browser tree to expand or
collapse by default. See “Customize Library Browser Appearance”.

Library Browser API: Programmatically refresh the Library Browser

Using the refresh method with the Library.LibraryBrowser?2 class,
you can programmatically refresh the library browser. To learn more, see
LibraryBrowser.LibraryBrowser2.

Compatibility Considerations

In previous releases, these two commands returned
LibraryBrowser.LibraryBrowser2:

slLibraryBrowser

Ib =
Ib = LibraryBrowser.LibraryBrowser2

In R2016b, each returns LibraryBrowser .LBStandalone. However, the API to access
Library Browser operations such as show and refresh has not otherwise changed.

Annotations: Click once to select annotation

In previous releases, a single click on an annotation prompted you to edit the annotation
text instead of selecting the annotation frame. In R2016b, click one time to select the
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annotation frame, which you can then drag or right-click to access the content menu.
Click a selected annotation to edit the text.

Default Model Font: Specify default font for model elements

You can now set the default font for models. Setting the default font affects any existing
model elements whose font you have not set manually as well as new model elements.
In your model, with no selection, select Diagram > Format > Font Styles for Models.
See “Specify Fonts in Models”. To use that font in new models, set the default font in the
default template. See “Default Model Template: Use your own customized settings when
creating new models” on page 1-14.

Simulink Preferences: Simplified and reorganized interface

Simulink Preferences now includes three panes:

+ General pane for generated file folders, background colors for printing and exporting,
and model display options

+ Editor pane for customizing the Simulink Editor

+ Model File pane for file saving options, including version notifications

Settings that are saved with the model no longer appear in Preferences. Use default

templates for these settings instead of preferences. For more information, see “Default

Model Template: Use your own customized settings when creating new models” on page
1-14.

For more information on the new Simulink Preferences panes, see “Set Simulink
Preferences”.

Simulink Editor Fonts: FreeType font engine replaces Windows GDI font
engine

On Windows® system, Simulink now uses the FreeType font engine. In previous releases,
it used the Windows graphics device interface (GDI) font engine. This change improves

the appearance of text in the user interface of the Simulink Editor.

If you are using a language that uses non-Latin characters, you might need to change the
font in the editor to one that supports your language. To set defaults for a model, with no
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selection in the Simulink Editor, select Diagram > Format > Font Styles for Model.
Change the font using the dialog box.
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Component-Based Modeling

Initialize and Terminate Function Blocks: Respond to events to model
dynamic startup and shutdown behavior

Use an Initialize Function block with a State Writer block to set the state of a block in
response to an initialize event. By default, the Initialize Function block includes a State
Writer block and an Event Listener block with the Event parameter set to Initialize.

Use the Terminate Function block with a State Reader block to read the state of a block
in response to a terminate event. By default, the Terminate Function block includes

a State Reader block and an Event Listener block with the Event parameter set to
Terminate.

Applications for these new blocks include:

* Starting up and shutting down an application component
* Initial condition calculations

+ Save and restore state from nonvolatile memory

For more information, see Initialize Function, Terminate Function, Event
Listener, State Reader, and State Writer block reference. Watch this video to
learn more

Variant Subsystem Condition Propagation: Automatically assign variant
conditions to blocks outside the subsystem for improved performance

When you specify variant conditions in models containing Variant Subsystem blocks,
Simulink propagates these conditions outside to determine which components of the
model are active during simulation.

A variant condition can be either a condition expression or a variant object.

For more information, see “Condition Propagation with Variant Subsystem”, or watch
this video to learn more.

Simulink Units Updates

These are changes to the Simulink Units:
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+ Allowed Units list:

The ASCII symbol of the reduced_Planck_constant unit has changed to h_bar. In
R20164a, this symbol was hbar. Starting in R2016b, hbar refers to hectobar.

+ Starting in R2016b, the dalton unit no longer allows the use of SI prefixes. In
R2016a, the dalton unit incorrectly allowed the use of SI prefixes.

Starting in R2016b, the deg unit is listed in both the English and SI (extended)
units lists. In R2016a, the deg unit was listed in only the SI (extended) list.

+ Starting in R2016b, the au unit refers to astronomical unit. In R2016a, au
incorrectly referred to attodalton.

+  Unit matching — As you type your unit in the Unit parameter, the software now
suggests close, but not exact, unit matches highlighted with a star.

*  Unit mismatching handling — Now when you click on the mismatched units warning
badge, the dialog lets you go to either the source or destination where the unit is
specified.

*  Undefined units handling — The Model Advisor check now has a column with
suggested unit alternatives that are a close match to the Simulink unit database.

Additional SimStruct Functions to Specify Units for Input and Output
Ports

To specify units for S-function input and output ports, use these SimStruct functions:

+ ssGetlnputPortunit

* ssGetOutputPortuUnit

* ssRegisterUnitFromExpr
+ ssSetlnputPortuUnit

+ ssSetOutputPortunit

Additional heterogeneous targets supported for concurrent execution

When configuring a model for concurrent execution, you can now build and download
partitions of the model to these additional heterogeneous targets:

Altera® Cyclone® SoC Rev. C development kit target
+ Altera Cyclone SoC Rev. D development kit target

Arrow® SoCKit development board target
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For more information, see “Specify a Target Architecture”.

Simulink.BusElement: SamplingMode property removed to support
having blocks specify whether to treat inputs as frame-based signals

The Sampl ingMode property of Simul ink.BusElement objects has been removed in
R2016b. Specify the sampling mode (sample-based and frame-based) of input signals at
the block level instead of at the signal level.

Compatibility Considerations

Scripts that use the Sampl ingMode property of Simul ink.BusElement objects continue
to work in R2016b. However, support for Sampl ingMode will be removed in a future
release.

Export functions allow periodic function calls

Export functions have been enhanced to allow periodic function calls. In addition, you
can now use the sample time of each export function call in your model to control the
scheduling of triggers. The order of the function-call triggers is determined by the sample
times of their corresponding export-function blocks. Using the sample time provides more
fine-grained control over how function-call triggers are scheduled in your model.

These enhancements provide the following advantages:

*  Multiple exported functions can have the same execution period.
+ Simulink now checks for sample time consistency in export functions.
+  Export-function models support auto step size and dataset logging.

* Sample time optimization results in more efficient code.

For more information, see “Export-Function Models”.

Compatibility Considerations

As a result of this enhancement, the root outport logging behavior for export-function
models in standalone simulations has changed. Previously, logging of root output ports
for export-function models was inconsistent with the multitasking behavior of regular
Simulink models, resulting in missing periodic rates in the logged output. Now, export-
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function models supports multitasking logging and dataset logging, which enable correct
logging of all periodic rates from root output ports.

If you rely on the previous logging behavior, you can enable dataset logging to get the
old output back. Note that dataset logging does not support asynchronous rate. In those
cases, specify the base rate in the root input ports.

Variant Refresh: Improved performance with removal of live refresh

Simulink models offer better performance with the removal of live refresh of active
models that contain Variant Subsystem blocks.

To update or refresh such models, click Diagram > Refresh Blocks (Ctrl + K) or
Simulation > Update Diagram (Ctrl + D) in Simulink.

Variant Subsystem: Convert Subsystems with physical ports to Variant

You can convert a Subsystem block that contains physical ports to a Variant Subsystem
block.

To do so, right-click the Subsystem block, in the context menu, click Subsystem &

Model Reference > Convert Subsystem to > Variant Subsystem.

Variant Reducer: Additional model reduction modes in Variant Reducer
(requires SLDV product license)

Use the Variant Reducer to reduce a variant model based on any one of these reduction
modes:

* Variant control variable values in the global workspace.
+ Variant control values specified as a comma-separated list.

* Variant configuration data object.

For more information, see “Reduce Models Containing Variant Blocks”.
Enhanced find_mdlrefs function: Keep models loaded that the function
loads

The find_mdlrefs function loads models in the model reference hierarchy of the
model that you specify. By default, the function closes those models, except for models
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that were already loaded before execution of the function. You can now use the
KeepModelsLoaded name-value pair to keep all the models loaded that the function
loads.

Subsystem conversion to referenced models: Automatic subsystem
wrapper and improved Goto and From block handling

The Model Reference Conversion Advisor and
Simulink.SubSystem.convertToModelReference function conversion creates a
wrapper subsystem automatically if the conversion modifies the Model block interface by
adding ports. The wrapper subsystem preserves the layout of the top model.

The conversion process no longer generates an error when Goto and From block pairs
cross model reference boundaries. The conversion automatically fixes the model,
regardless of how you set the Fix errors automatically ("Autofix") option. The
conversion now produces a message highlighting the changes it made, so that you can
determine whether the changes produce the desired results.

For more information, see “Convert a Subsystem to a Referenced Model” and
Simulink.SubSystem.convertToModelReference.

Disallow multiple iterations of root Inport function-call with discrete
sample time

For a function-call root Inport block with a discrete sample time vector, you cannot have
multiple times at the same sample time.
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Default Model Template: Use your own customized settings when creating
new models

In R2016b, you can specify a model template to use for all new models. Create a model
with the configuration settings and blocks you want, then export the model to a template.
To reuse these settings in every new model, make the new template your default model
template using the Simulink start page or the Simulink.defaultModel Template
function.

In R2016b, after setting a default model template, every new model uses that template,
for example, when you press Ctrl+N, when you use new model buttons, or when you use
new_system. In the Simulink Editor, the default template name appears at the top of
the list when you select File > New > MyDefaultTemplateName.

For details, see “Use Customized Settings When Creating New Models”, or watch this
video to learn more.

Compatibility Considerations

Action R2016a R2016b
Create new models using: |Factory You can specify your default template.
. . default blank
* Ctrl+N in the Editor |y 0del Until you choose a new default template, the
or start page. default template remains the blank model.

*  New model toolbar
buttons in the Editor
and Library Browser

new_system

Specify configuration You could The configuration defaults, font defaults,
setting defaults use Simulink |and display defaults are removed from the
Preferences to |Simulink Preferences dialog box in R2016b.
specify default |Use a model template instead.

parameters for
new models.
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Action R2016a R2016b

If you previously saved configuration
defaults in the Simulink Preferences, in
R2016b, Simulink converts these settings
to a model template, called Converted
Simulink Preferences in the start page.

If you previously specified configuration
defaults and ran scripts on the

root block diagram, then to use

the old behavior, run the script
enablePreferencesCompatibilityMode.

Specify model fonts You could not |In the Simulink Editor, with no model
change fonts |element selected, choose Diagram >
in existing Format > Font Styles for Model. To
models. use the specified fonts as defaults for new

models, export the model to a template.

Upgrade Advisor API: Automate the process of upgrading large model
hierarchies

In R2016b, you can call upgrade or analyze on the output argument of the
upgradeadvisor function. You can use the API to analyze only or also perform

automatic fixes where available.

For details, see upgradeadvisor, or watch this video to learn more.

Project-Wide Search: Search inside all models and supporting files

Search across all your project files in one place. You can find matches inside model files,

MATLAB? files, and other project files such as PDF and Microsoft” Word files. On the
Simulink Project tab, click Search and enter some characters to search for.

Open search results to locate specific items, e.g., highlight blocks in models, specific lines
in MATLAB files. Filter results by file type, status, or label.

For details, see “Search Inside Project Files and Filter File Views”.
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Refactoring Tools: Rename folders and automatically replace all
references

In a Simulink project, when you rename a folder, the project checks for impact in other
project files and offers fixes. You can find and fix impacts and avoid refactoring pain
tracking down other affected files. Automatic renaming is helpful in preventing errors
that result if you change names or paths manually and overlook or mistype one or more
instances of the name.

For details, see “Automatic Updates When Renaming, Deleting, or Removing Files”.

Project Toolbox Analysis: Find products and toolboxes used by a project

In a Simulink project, in the Impact graph view, you can find the required toolboxes for
the whole project or for selected files. You can see which products a new team member
requires to use the project, or find which file is introducing a product dependency.

For details, see “Find Required Toolboxes”.

Project Derived File Analysis: Find out-of-date .p, -sIxp. and .mex files
in a project

In a Simulink project, you can run checks to ensure your derived files are up to date, and
choose to rebuild the files.

After running dependency analysis, the Impact view shows:

+ Relationships between source and derived files (such as .m and .p files, sIx/sIxp,
ssc/sscp, c/mex files).

+ Warnings when any derived file is out of date compared to its source file.

New project checks help you manage derived files:

*  You can automatically rebuild out-of-date P-code files by running the project checks.

+ If you rename a source file, the project detects impact in the derived file and prompts
you to update it.

For details, see “Check Dependency Results and Resolve Problems”.
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Project Export Profiles: Share specified files to zip archive

You can specify export profiles to control the project files you send to a zip archive. You
can choose to exclude files, for example, when sharing a release version.

For details, see “Archive Projects in Zip Files”.

Project Batch Job Report: Archive results in a document

After running a batch job on project files, you can view and archive results in a batch job
file. For details, see “Run a Simulink Project Batch Job and Publish Report”.

Git Submodules: Include submodules in your project

You can specify Git™ submodules to include in your project, to reuse code from another
repository.

For details, see “Add Git Submodules”.

C/C++ file dependency analysis: View dependencies between C/C++
source and header files in the Impact graph

Use Simulink Project dependency analysis to explore dependencies between C/C++
source and header files in the impact graph.

For details, see “Perform Impact Analysis”.

Updated source control SDK: Write a source control integration providing
file-based actions and annotations

You can use the source control Software Development Kit (SDK) to integrate Simulink
Project with third-party source control tools. You can now use the updated SDK to
write a source control integration that can provide file-based actions and annotations.
An integration written using this API works with R2016b onwards. If you require a
backwards-compatible integration, you can continue to use the old interfaces.

For details, see “Write a Source Control Integration with the SDK”.
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Diff Tools: Customize external source control tools to use MATLAB to
compare and merge

Use MATLAB Comparison tool to review changes to files such as MAT data and data
dictionaries from your external source control client.

For details, see “Customize External Source Control to Use MATLAB for Diff and
Merge”.

SVN Cleanup: Fix problems with working copy locks

Remove stale working copy locks using SVN Cleanup. See “Get SVN File Locks”.
Command-line Impact Analysis: Update and analyze the dependencies
graph programmatically

In R2016b, you can access the dependency graph using the Simulink project API. You can
perform command-line project impact analysis and get required files.

For details, see “Get File Dependencies”.
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Model Data Editor: Configure model data properties using a table within
the Simulink Editor

The Model Data Editor allows you to inspect and edit data items (signals, data stores,
and parameters) in a list that you can sort, group, and filter. You can then configure
properties and parameters without having to locate the items in the block diagram.

While creating and debugging a model, you can configure multiple data items at once
by selecting the corresponding signals and blocks in the block diagram. Work with the
selected items in the Model Data Editor instead of opening individual dialog boxes.

Use the Model Data Editor to configure:

+ Instrumentation for signals and data stores, which means you want to view and
collect the simulation values. For example, you can configure signals and data stores
to stream values to the Simulation Data Inspector.

* Design attributes such as data type, minimum and maximum value, and physical
unit. You specify these attributes to control:

+  The values of numeric block parameters, such as the Gain parameter of a Gain
block.

The interaction (interface) between components through Inport and Outport blocks
and data stores.

+ Storage classes for code generation. See “Model Data Editor for applying storage
classes to Inport blocks, Outport blocks, signals, and Data Store Memory blocks”.

To use the Model Data Editor, in a model, select View > Model Data. See “Configure

Data Properties by Using a Table”, or watch this video to learn more.

Output Logging: Log data incrementally, with support for rapid
accelerator mode and variant conditions

For logging output (Configuration Parameters > Data Import/Export > Output)
using Dataset format:

+ If you enable Configuration Parameters > Data Import/Export > Log Dataset
data to file, output data is logged to a MAT-file, using only a small constant amount
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of memory. Before R2016b, when you accessed the output logged data, Simulink
loaded the entire data at once. Now Simulink loads that data into the workspace
incrementally. For information about logging to a MAT-file, see “Log Data Using
Persistent Storage”.

* In addition to the simulation modes previously supported, you can now log to memory
or to a MAT-file in rapid accelerator mode.

+ For the active variant condition, Simulink creates a Dataset object with the logged
data. For inactive variant conditions, Simulink creates MATLAB timeseries with
zero samples.

Logging Inside For Each Subsystem: Log signals inside a For Each
subsystem by marking lines with antennas

Performing signal logging in For Each subsystems no longer requires adding an Outport
block outside of the subsystem for each signal that you want to log. You can mark for
signal logging nonbus signals inside For Each subsystems. Directly logging signals in a
For Each subsystem simplifies the model layout and editing. For details, see “Log Signals
in For Each Subsystems”.

Logged Dataset Data Analysis: Call same function for all timeseries
objects in logged Dataset data

Use the new Simulink.SimulationData.forEachTimeseries function to call
a built-in or user-defined function on each MATLAB timeseries object that you
specify as input. For example, you can use this function to resample every element
of a structure of timeseries objects obtained by logging a bus signal. You can

use ForEachTimeseries with a function that returns a scalar. You can specify a
timeseries object, an array of timeseries, a structure with timeseries at leaf
nodes, or an array of structures with timeseries at leaf nodes.

Scalar expansion of initial value for data store

Before R2016b, if a data store (Data Store Memory block or Simul ink.Signal object)
represented an array (nonscalar) signal, you specified the initial value of the data

store by using an array of the same dimensions. You could not use scalar expansion by
specifying a scalar initial value. For several other blocks, scalar expansion enables you to
specify the same initial value for each element of a nonscalar signal.
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In R2016b, you can take advantage of scalar expansion for data stores with some
exceptions. For more information, see “Specify Initial Value for Data Store”.

Technique to determine whether signal has variable size

You can use the programmatic parameter Compi ledPortDimensionsMode of a block
output port to determine whether the associated signal is a variable-size signal. For more
information, see “Programmatically Determine Whether Signal Line Has Variable Size”.

View your model configuration parameters as a group on the All
Parameters tab

Previously, in the Configuration Parameters dialog box, the All Parameters tab grouped
configuration parameters only by the category that was displayed in the first column. In
R2016Db, this tab groups the parameters for each category into the same groups used on
the Commonly Used Parameters tab. Headings that describe the category and group
replace the Category column. The new Advanced Parameters group for each category
contains parameters only available on the All Parameters tab.

For more information, see “Configuration Parameters Dialog Box Overview”.

Enhanced error reporting and extended syntax for specifying argument
dimensions for function specifications in Legacy Code Tool

In R2016b, these features enhance the usability of the Legacy Code Tool:

* Improved error reporting — provides more specific information about argument
specification errors.
+  Extended syntax for specifying argument dimensions — In addition to the size
function, you can specify function argument dimensions using expressions with:
The numel function
* Arithmetic operators: +, —, *, /

+ Integer and floating-point literals

Class to package and share breakpoint and table data for lookup tables

You can use the new classes Simulink.LookupTable and Simulink.Breakpoint to
store table and breakpoint data for lookup tables.
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When you share data between lookup table blocks by using variables in a workspace or
data dictionary, use this technique to improve model readability by:

+ Clearly identifying the data as parts of a lookup table.
+ Explicitly associating breakpoint data with table data.

For more information, see “Package Shared Breakpoint and Table Data for Lookup
Tables”.

Simulink Coder™ and Embedded Coder® enable you to use this technique to package
the data in the generated code for calibration according to the ASAP2 and AUTOSAR
standards. See “Storage of lookup tables for calibration according to ASAP2 and
AUTOSAR standards”.

These blocks have additional parameters to support the use of Simul ink.LookupTable
and Simul ink.Breakpoint objects:

* n-D Lookup Table
* Prelookup
+ Interpolation Using Prelookup

Root Inport Mapping Tool Updates

The Root Inport Mapping Tool has the following updates:

+ Select a subset of scenarios for mapping and choose a mapping mode different from
other scenarios (for more information, see “Map Signal Data to Root Inports”).

+ If you import from a sheet whose name does not follow MATLAB variable name rules,
the Root Inport Mapping tool now uses a modified sheet name. For more information,
see “Supported Microsoft Excel File Formats”.

Option to disable resolution of signals and states to Simulink._Signal
objects

To configure signal or state properties such as data type, minimum and maximum
values, and storage class, you can create a Simulink.Signal object in a workspace or
data dictionary. The signal property Signal name must resolve to Simulink signal
object, the block parameter State name must resolve to Simulink signal object,
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and the model configuration parameter Signal resolution control how the signal or
state name corresponds to the object.

In R2016b, Signal resolution has an additional option, None. When selected, this
setting prevents the signals, states, Stateflow data, and MATLAB Function block data
in the model from acquiring settings from Simul ink.Signal objects. Use this setting
to reduce the dependency of the model on variables and objects in workspaces and data
dictionaries, which can improve model portability, readability, and ease of maintenance.

However, selecting None does not affect data stores that you define by creating
Simulink.Signal objects (instead of Data Store Memory blocks).

For more information about Signal resolution, see “Signal resolution”.

Help fixing configuration errors from Diagnostic Viewer

For some configuration error messages, the Diagnostic Viewer provides these methods for
fixing the error:

+ To fix simple configuration errors, click the Fix button. The software updates
the parameter. Green or red text in the diagnostic viewer reports if the change is
successful. To see the highlighted parameter in the Configuration Parameters dialog
box before fixing, click the parameter link.

Note: If you are modifying a referenced configuration, or if the parameter change
results in a model reference incompatibility, a dialog box warning allows you to cancel
the operation.

+ To fix a configuration error with a more complex solution or multiple solutions,
click the Open button next to your chosen solution. Then, update the highlighted
parameter in the Configuration Parameters dialog box.

Metadata for Logging to Persistent Storage: Simulation metadata contains
persistent storage logging settings to facilitate analysis of data from
multiple simulations

R2016a introduced the option for you to log Dataset format simulation data to
persistent storage in a MAT-file. To do so, select Configuration Parameters > Data

Import/Export > Log Dataset data to file. In R2016b, Simulink stores metadata
about logging to persistent storage. When you run multiple simulations using parallel
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simulations or batch processing, specify a different persistent storage MAT-file for each
simulation. Then you can use the metadata to provide context for analyzing the logged
data stored in each file.

If you use single simulation output, Simulink creates a
Simulink.SimulationMetadata object. In R2016b, this object includes in its
Model Info structure a new LoggingInfo structure that contains two fields:

* LoggingToFile — Indicates whether logging to persistent storage is enabled (*on*
or "off")

* LoggingFileName — Specifies the resolved file name for the persistent storage
MAT-file (if LoggingToFileis "on")

The MAT-file used for persistent storage contains a new SimulationMetadata variable
that stores the same simulation metadata as the Simulink.SimulationMetadata
object.

For details, see “Save Logged Data from Successive Simulations”.

Improved display of large arrays by Model Explorer and
Simul ink.Parameter property dialog boxes

Before R2016b, for numeric MATLAB variables and Simul ink.Parameter objects, the
Model Explorer Value column displayed large arrays as read-only text, such as <3x5x3
double>. The property dialog box for Simul ink.Parameter objects also used this read-
only text.

In R2016b, the Model Explorer and property dialog boxes display the entire value of large
arrays. To modify the elements in the array, you can edit the displayed text.

Arrays with three or more dimensions appear as an expression that contains a call to the
reshape function. To edit the values in the array, modify the arguments of this reshape
call.

For more information, see “Edit and Manage Workspace Variables Used by Models”.
Configuration set in base workspace resolves variables in base
workspace

For a model that references a configuration set in the base workspace, if the
configuration set uses a variable, Simulink resolves the variable in the base workspace.
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Raspberry Pi 3 Support: Run Simulink models on Raspberry Pi 3
hardware

The Simulink Support Package for Raspberry Pi™ Hardware now supports Raspberry Pi
3 hardware.

Watch this video to learn more.

Arduino: Improved External mode over serial communication

The external mode feature on the Simulink Support Package for Arduino® Hardware is
now improved with a faster serial communication protocol. The new protocol reduces data
drop during data logging. With this change, increasing the baud rate also increases the
data logging performance.

Simulink Support Package for Samsung GALAXY Android Devices
renamed to Simulink Support Package for Android Devices

The Simulink Support Package for Samsung GALAXY® Android™ Devices has been
renamed to the Simulink Support Package for Android Devices.

Google Nexus Support: Run Simulink models on Google Nexus Android
devices

The Simulink Support Package for Android Devices now supports Google® Nexus Android
devices.

Watch this video to learn more.
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Block Enhancements

State Reader and Writer Blocks: Reset and record states during model
execution

Use the State Writer block with an Initialize Function block to set the state of a block in
response to an initialize event. Use the State Reader block with a Terminate Function
block to read the state of a block in response to a terminate event.

Blocks with state include:

+ Discrete State-Space

* Discrete-Time Integrator
* Discrete Transfer Fcn

* Discrete Filter

* Delay

* Unit Delay

* S-Function (with one data type work vector declared as a discrete-state vector )

For more information, see Initialize Function, Terminate Function, Event
Listener, State Reader, and State Writer block reference.

MATLAB System Block Support for Global Data: Access Simulink data
stores from System objects using global variables
The MATLAB System block now has ability to share data between multiple MATLAB

System blocks. For more information, see “Data Sharing with the MATLAB System
Block”.

MATLAB System block now supports enumerated data types

The MATLAB System block now supports enumerated data types.
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MATLAB System Block Support for LAPACK: Generate faster standalone
code for linear algebra in a MATLAB System block

For improved simulation speed of certain linear algebra function calls in a System
object™ associated with a MATLAB System block, the simulation software can call
LAPACK functions. In R2016b, if you use Simulink Coder to generate C/C++ code from
your model, you can specify that the code generator produce LAPACK function calls. If
you specify that you want to generate LAPACK function calls, and the input arrays for
the linear algebra functions meet certain criteria, the code generator produces calls to
relevant LAPACK functions. The code generator uses the LAPACKE C interface.

LAPACK is a software library for numerical linear algebra. MATLAB uses this library
in some linear algebra functions, such as eig and svd. Simulink uses the LAPACK
library that is included with MATLAB. Simulink Coder uses the LAPACK library that
you specify. If you do not specify a LAPACK library, the code generator produces code for
the linear algebra function instead of generating a LAPACK call.

To generate LAPACK function calls and link to a specific LAPACK library, follow the
procedure in “Speed Up Linear Algebra in Code Generated from a MATLAB Function
Block” in the Simulink Coder documentation.

In R2016a, when you configured your model to generate LAPACK calls for standalone
code, the configuration applied to MATLAB Function blocks and Stateflow charts. In
R2016Db, the configuration also applies to MATLAB System blocks. If you previously
configured your model to generate LAPACK calls for MATLAB Function blocks or
Stateflow charts, the code generator now also generates LAPACK calls for qualifying
linear algebra calls in MATLAB System blocks.

Simpler way to call System objects

Instead of using the step method to perform the operation defined by a System object,
you can call the object with arguments, as if it were a function. The step method will
continue to work. This feature improves the readability of scripts and functions that use
many different System objects.

For example, if you create a dsp.FFT System object named FFt1024, then you call the
System object as a function with that name.

ft1024 = dsp.FFT("FFTLengthSource®, "Property®, ...
"FFTLength" ,1024);
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FF£1024(x)

The equivalent operation using the step method is:

11024 = dsp.FFT("FFTLengthSource®, "Property”,
"FFTLength",1024);
step(FFft1024,x)

When the step method has the System object as its only argument, the function
equivalent has no arguments. This function but must be called with empty parentheses.
For example, step(sysobj) and sysobj () perform equivalent operations.

System objects support for additional inputs, global variables, and
enumeration data types

+  System objects in code generated using MATLAB Coder can have up to 1024 inputs.

* You can use global variables declared in System objects to exchange data with the
Data Store Memory block in Simulink. You can use these variables in generated
code.

*  Enumeration data types for System objects included in Simulink using the MATLAB
System block is supported. Enumerations restrict data to a finite set of data values
that inherit from int8, uint8, intl6, uintl6, Iint32, or Simulink. IntEnumType
data types, or a data type you define using Simul ink.definelntEnumType.

Prelookup and Interpolation Using Prelookup Block Bus Support: Simplify
and extend use of index and fraction signals

The Prelookup and the Interpolation Using Prelookup blocks use two signals as output
and input, respectively:

* An index of the breakpoint set element

* An interval fraction that represents the normalized position on the breakpoint
interval between the index and the next index value if the input is in range.

In R2016b, you can use a bus to combine index and fraction signals. Benefits of using a
bus for these signals include:

+ Simplifies the model by tying these two related signals together.
+ Creates a testpoint DpResult structure for the AUTOSAR 4.0 library.
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* For the AUTOSAR 4.0 library, avoids the creation of extra copies during code
generation when the Prelookup and Interpolation Using Prelookup blocks are in
separate models.

For more information, see the Prelookup and Interpolation Using Prelookup
blocks.

From Spreadsheet block updates

The From Spreadsheet block now has a Range parameter. Use this parameter to
select ranges of data in your spreadsheet.

Property inspector available for Simulink blocks

Property inspector view is now available for Simulink blocks. For more information on
the property inspector, see “Setting Properties and Parameters”.

Manual Variant Source and Sink: Switch manually between different
variants without using conditions

Use the Manual Variant Source and Sink blocks to switch between choices at input and
output ports. You can double-click the block to toggle between the choices.

For more information, see Manual Variant Source and Manual Variant Sink.

Block Mask: Improved performance while evaluating mask parameter in
fast restart mode

Once a model is initialized, only the tunable mask parameters are evaluated thus
resulting in improved performance while evaluating the mask parameters.

Slider Range Parameter: Dynamically change the range of slider and dial
parameter

You can change the range of the slider and dial parameters on a mask using callback
code.

For more information, see the Change Slider range Dynamically model in
slexMaskParameterOptionsExample.
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Some types of unit delay blocks obsoleted

These unit delay blocks were removed from the Discrete library in R2016b. In new
models, use the Delay block (with parameters set appropriately). For example, you can
use the Resettable Delay block to replace the Unit Delay Resettable External IC block.
The Resettable Delay is the Delay block configured to reproduce the behavior of the Unit
Delay Resettable External IC block.

Existing models that contain these blocks continue to work for backward compatibility.

*  Unit Delay Enabled

*  Unit Delay Enabled Resettable

*  Unit Delay Enabled External IC

*  Unit Delay Enabled Resettable External IC

*  Unit Delay External IC

*  Unit Delay Resettable

+ Unit Delay Resettable External IC

*  Unit Delay With Preview Enabled

*  Unit Delay With Preview Enabled Resettable

*  Unit Delay With Preview Enabled Resettable External RV
*  Unit Delay With Preview Resettable

*  Unit Delay With Preview Resettable External RV

Enhanced discrete block behavior

Previously, if your model used a variable-step solver, Simulink reported an error when it
was unable to assign an appropriate sample time to the discrete blocks.

In this release, this discrepancy has been addressed so that discrete blocks always
receive an appropriate sample time. The error message no longer appears.

In addition, for the following blocks, the default sample time setting has changed from 1
to —1:

* Discrete-Time Integrator
*  Zero-Order Hold
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Discrete Zero-Pole

Discrete PID Controller
Discrete PID Controller (2DOF)
Discrete State-Space
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MATLAB Language Support: Use recursive functions and anonymous
functions in a MATLAB Function block

Recursive functions

In R2016b, you can use recursive functions in MATLAB code that is intended for code
generation. To generate code for recursive functions, MATLAB Coder uses compile-
time recursion or run-time recursion. With compile-time recursion, the code generator
creates multiple copies of the function in the generated code. The inputs to the copies
have different sizes or constant values. With run-time recursion, the code generator
produces recursive functions in the generated code. You can influence whether the code
generator uses compile-time or run-time recursion by modifying your MATLAB code.
You can disallow recursion or disable run-time recursion by modifying configuration
parameters. See “Code Generation for Recursive Functions”.

The block-level function in a MATLAB Function block cannot be a recursive function, but
it can call a recursive function.

Anonymous functions

In R2016b, you can use anonymous functions in a MATLAB Function block. For example,
a MATLAB Function block can contain the following MATLAB code that defines an
anonymous function that finds the square of a number:

sgr = @(X) x-"2;
a = sqr(b);

Anonymous functions are useful for creating a function handle to pass to a MATLAB
function that evaluates an expression over a range of values. For example, this MATLAB
code uses an anonymous function to create the input to the fzero function:

b
c
X

2;
3.5;
fzero(@(xX) x"3 + b*x + ¢,0);

You cannot use anonymous functions for Simulink signals, parameters, or data store
memory. For additional limitations, see “Code Generation for Anonymous Functions”.
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Variable-Size Cell Array Support: Use cel I to create a variable-size cell
array in a MATLAB Function block

To create a variable-size cell array in a MATLAB Function block, you can use the cell
function. For example:

function z = mycell(n, j)
assert(n < 100);
x = cell(1,n);
for i = 1:n
x{i} = i;
end
z = x{J};

end

See “Definition of Variable-Size Cell Array by Using cell”.

Error for testing equality between enumeration and character array in a
MATLAB Function block

For MATLAB code in a MATLAB Function block, an enumeration class must derive from
a built-in numerical class. In R2016b, MATLAB introduces a new behavior for testing
equality between these enumerations and a character array or cell array of character
arrays. In previous releases, MATLAB compared the enumeration and character array
character-wise. The behavior in a MATLAB Function block matched the MATLAB
behavior. In R2016b, MATLAB compares the enumeration name with the character
array. In R2016b, if a MATLAB Function block tests the equality of an enumeration and
a character array, simulation or code generation ends with this error message:

Code generation does not support comparing an enumeration to a
character array or cell array with the operators * and "~=

Consider this enumeration class:

classdef myColors < int8
enumeration
RED(1),
GREEN(2)
end
end

The following code compares an enumeration with the character vector "RED":
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mode = myColors.RED;
z = (mode == "RED");

In previous releases, the answer in MATLAB and generated code was:

0 0 0

In R2016b, the answer in MATLAB is:

1

In R2016b, simulation or code generation ends with an error.

Compatibility Considerations

If you want the behavior of previous releases, cast the character array to a built-in
numeric class. For example, use the built-in class from which the enumeration derives.

mode = myColors.RED;
z = (mode == Iint8("RED"));

Incremental build for relocation of MATLAB program files on the MATLAB
path

In previous releases, for MATLAB files called by a MATLAB Function block, incremental
builds treated a relocated file on the MATLAB path as an updated file, even if the
contents or timestamp did not change. The relocation of an unchanged file called by

a MATLAB Function block caused a rebuild. In R2016b, incremental builds treat
unchanged, relocated MATLAB files on the MATLAB path as unchanged files. Relocation
of an unchanged MATLAB file called by a MATLAB Function block does not cause a
rebuild.

To specify incremental builds, set Simulation target build mode to Incremental
build.

Additional 1/0 Support: Generate code for fseek, ftell, fwrite

+ fTseek
+ ftell
+ fwrite
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See “Data and File Management in MATLAB” in “Functions and Objects Supported for
C/C++ Code Generation — Category List”.

Code generation for additional MATLAB functions

+ cplxpair
+ fminbnd

+ inpolygon
+ isenum

+ polyeig

* repelem

See “Functions and Objects Supported for C/C++ Code Generation — Alphabetical List”.

Code generation for additional Audio System Toolbox functions

* integratedLoudness
+ octaveFilter

+  weightingFilter

See “Audio System Toolbox” in “Functions and Objects Supported for C/C++ Code
Generation — Category List”.

Code generation for additional Computer Vision System Toolbox functions

+ cameraPoseToExtrinsics
+ extrinsicsToCameraPose

See “Computer Vision System Toolbox” in “Functions and Objects Supported for C/C++
Code Generation — Category List”.

Statistics and Machine Learning Toolbox Code Generation: Generate code
for prediction by using SVM and logistic regression models
You can generate C code that classifies new observations by using trained, binary

support vector machine (SVM) or logistic regression models, or multiclass SVM or logistic
regression via error-correcting output codes (ECOC).
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saveCompactModel compacts and saves the trained model to disk.

loadCompactModel loads the compact model in a prediction function that you
declare. The prediction function can, for example, accept new observations and return
labels and scores.

predict classifies and estimates scores for the new observations in the prediction
function.

+ To classify by using binary SVM models, see predict.

+ To classify by using binary logistic regression models, see predict.

To classify by using multiclass SVM or logistic regression via ECOC, see predict.

Communications and DSP Code Generation: Generate code for additional
functions

Communications System Toolbox

igimbal
comm.BasebandFileReader
comm.BasebandFileWriter
comm.EyeDiagram

comm.PreambleDetector

See “Communications System Toolbox” in “Functions and Objects Supported for C/C++
Code Generation — Category List”.

DSP System Toolbox

dsp.MovingAverage
dsp.MovingMaximum
dsp.MovingMinimum
dsp.MovingRMS
dsp.MovingStandardDeviation
dsp.MovingVariance
dsp.MedianFilter
dsp.BinaryFileReader
dsp.BinaryFileWriter
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* dsp.Channelizer

* dsp.ChannelSynthesizer

See “DSP System Toolbox” in “Functions and Objects Supported for C/C++ Code
Generation — Category List”.

Phased Array System Toolbox

* musicdoa

+ pambgfun

+ taylortaperc

* phased.GSCBeamformer

* phased.WidebandBackscatterRadarTarget
+ phased.WidebandTwoRayChannel

* phased. MUSICEstimator

* phased MUSICEstimator2D

See “Phased Array System Toolbox” in “Functions and Objects Supported for C/C++ Code
Generation — Category List”.

Conditional breakpoints for run-time debugging

To help you debug code, you can enter a MATLAB expression as a condition on a
breakpoint inside a MATLAB Function block. Simulation then pauses on that breakpoint
only when the condition is true. To set a conditional breakpoint, in the MATLAB
Function block editor, right-click beside the line of code and select Set Conditional
Breakpoint. Type the condition in the pop-up window. You can use any valid MATLAB
expression as a condition. This condition expression can include numerical values and
any data that is in scope at the breakpoint.

When you right-click a breakpoint, you can choose:

+ Set/Modify the condition
+ Disable breakpoint
+ Clear breakpoint

You can also perform these actions from the Breakpoints menu in the MATLAB
Function block editor.
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Compiler optimization parameter support for faster simulation

In R2016b, Simulink applies the setting for the configuration parameter Compiler
optimization level to MATLAB Function blocks. To speed up the simulation run-
time for your model, set the configuration parameter to Optimizations on (faster
runs). The application of compiler optimizations might consume extra time during the
build process. The default setting, Optimizations off (faster build) disables compiler
optimizations and provides the fastest build times.

Run-Time error stack in Diagnostic Viewer

In the Diagnostic Viewer, some error messages display the run-time stack information
and include the line numbers for the MATLAB code. You can trace these errors that
occur in MATLAB Function blocks to the line of code. When you select the line number,
the link opens the editor and highlights the corresponding line of code. Previously, the
error message did not provide information about the location of the error.



Modeling Guidelines

Modeling Guidelines

Modeling guidelines for high-integrity systems

The following are new modeling guidelines to develop models and generate code for high-
integrity systems:

* “hisl_0033: Usage of Lookup Table blocks”

+ “hisl_0034: Usage of Signal Routing blocks”

* “hisl_0036: Configuration Parameters > Diagnostics > Saving”

* “hisl_0037: Configuration Parameters > Model Referencing”

+ “hisl_0038: Configuration Parameters > Code Generation > Comments”

* “hisl_0039: Configuration Parameters > Code Generation > Interface”

* “hisl_0047: Configuration Parameters > Code Generation > Code Style”

* “hisl_0049: Configuration Parameters > Code Generation > Symbols”
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Automatic Solver Option: Set up and simulate your model more quickly
with automatically selected solver settings

Starting with R2015b, you can use the auto solver to select a solver and step size for
simulating a model. The auto solver suggests a fixed-step or variable-step solver along
with maximum step size based on the dynamics of the model. Select the auto solver in
the solver pane and accept recommended settings in the solver information dialog box.
For more information, see Use Auto Solver to Select a Solver.

Starting with R2016a, auto solver calculates the stiffness of a model. For stiff models,
auto solver selects odel5s. For more information, see Auto Solver Heuristics.

One-Click Display: Click a signal line when the simulation is running to
view the current value

When you simulate your model, you can now display the port value label for a signal by
clicking it. This option is selected by default.

For more information, see Display Value for a Specific Port or watch this video to learn
more.

Simulation Metadata Diagnostics: Understand why a simulation has
stopped in batch or individual runs

You can now use diagnostics in SimulationMetadata to understand why a simulation
stopped. The metadata object has a new property called ExecutionlInfo. This property
contains information about stop events, error, and warning diagnostics. You can use the

information in ExecutionlInfo to troubleshoot individual runs or each run in a batch
simulation.

See Simulink.SimulationMetadata to learn more.
Multi-Input Root Inport Mapping: Connect multiple sets of input signals to
your Simulink model for interactive or batch simulation

The Root Inport Mapping tool now supports the connection of multiple sets of input
signals to your Simulink model for interactive or batch simulation.


http://www.mathworks.com/help/releases/R2016a/simulink/ug/use-auto-solver-to-select-a-solver.html
http://www.mathworks.com/help/releases/R2016a/simulink/ug/use-auto-solver-to-select-a-solver.html#bu55z41-1
http://www.mathworks.com/help/releases/R2016a/simulink/ug/displaying-block-outputs.html#bti2_90
https://www.mathworks.com/videos/one-click-display-116248.html
http://www.mathworks.com/help/releases/R2016a/simulink/slref/simulink.simulationmetadata-class.html
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For more information, see Map Root Inport Signal Data or watch this video to learn
more.

Simulation for Mixed Targets: Simulate system-level designs that integrate
referenced models targeting an assembly of heterogeneous embedded
devices

You can simulate a parent system model that includes referenced models configured for
heterogeneous embedded devices. For example, you can simulate a parent model that
has a referenced model Configuration Parameters > Hardware Implementation
> Device vendor parameter set to ARM Compatible and another referenced model
with that parameter set to ASIC/FPGA. Simulink models can now simulate system
engineering level models that target multiple hardware devices.

Time Out feature for Performance Advisor run time

You can now specify a run-time duration for Performance Advisor by selecting the Time
Out option. For models with long simulation times, use this option to limit the time
period for Performance Advisor runs. For more information, see Specify Runtime for
Performance Advisor.

Solver Profiler to speed up simulation performance

You can use Solver Profiler to examine solver behavior of variable step solvers and model
behavior to identify issues that can contribute to poor simulation performance. Run
Solver Profiler on models that fail to simulate or that have long simulation times. When
you pause or stop the simulation, Solver Profiler displays information gathered during
runtime including an analysis of conditions that can slow down simulation. Use this data
to examine the model simulation for solver resets, zero crossings and solver exceptions.

Solver Profiler highlights states in the model that contain solver errors. You can also
launch States Explorer from Profiler to further investigate the state plot of a model state.

For more information, see Examine Model Dynamics Using Solver Profiler.

Diagnostic Viewer performance improvement

The Diagnostic Viewer performs better and faster when handling large number of similar
warnings from Simulink operations.
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Variant Source and Sink Blocks with Condition Propagation: Design
variant choices and automatically remove unneeded functionality based
on block connectivity

Simulink provides two blocks to visualize implementations of variant choices in a model
graphically—Variant Source and Variant Sink.

When you compile the model, Simulink determines which variant control evaluates to
true. Simulink then deactivates blocks that are not tied to the variant control being true
and visualizes the active connections.

When you specify variant conditions in models containing Variant Source and Variant
Sink blocks, Simulink propagates these conditions backward and forward from these
blocks to determine which components of the model are active during simulation.

See Variant Condition Propagation with Variant Sources and Sinks or watch this video
to learn more.

Scoping Simulink Functions: Call Simulink Function blocks within a
subsystem hierarchy

Defining the scope of Simulink functions in a Simulink model allows you to modularize
your model by limiting the visibility and access of functions. Simulink uses subsystems
to define the local scope of a function. See Define Scope of Simulink Function Blocks and
Simulink Functions in Simulink Models, or watch this video to learn more.

Simulink Units: Specify, visualize, and check consistency of units on
interfaces

Simulink now supports the specification of physical units as part of signal attributes.
This capability enables you to specify unit attributes at the boundaries of components
such as subsystems and models. To learn more, see Unit Specification in Simulink
Models or watch this video.

For a list of supported unit systems and their units, see Allowed Unit Systems.


http://www.mathworks.com/help/releases/R2016a/simulink/slref/variantsource.html
http://www.mathworks.com/help/releases/R2016a/simulink/slref/variantsink.html
http://www.mathworks.com/help/releases/R2016a/simulink/ug/variant-condition-propagation-with-variant-source-and-sink-blocks.html
https://www.mathworks.com/videos/variant-source-and-sink-blocks-with-condition-propagation-116253.html
http://www.mathworks.com/help/releases/R2016a/simulink/ug/functions-and-callers-scoping.html
http://www.mathworks.com/help/releases/R2016a/simulink/ug/functions-and-callers.html
https://www.mathworks.com/videos/scoping-simulink-functions-116251.html
http://www.mathworks.com/help/releases/R2016a/simulink/ug/units-in-simulink.html
http://www.mathworks.com/help/releases/R2016a/simulink/ug/units-in-simulink.html
https://www.mathworks.com/videos/simulink-units-116249.html
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Units in Simulink.Parameter and Simulink.Signal Objects

The DocUnits property is now Units. Use this property to specify units for signals.

Note: You can still continue to use the DocUnits field to access or set the property. This
capability maintains backward compatibility for existing MATLAB code, MAT-files, and
Simulink data dictionaries that use the DocUnits field.

Specifying units in MATLAB Function blocks

Simulink supports the specification of a unit property for data inputs and outputs of
MATLAB Function blocks. Specify units for input and output data by using the Unit
(e.g., m, m/s*2, N*m) parameter on the Ports and Data Manager.

During model update, Simulink checks for inconsistencies in units between input and
output data ports and the corresponding Simulink signals.

Units for logging and loading signal data

You can include units in signal data that you log or load.

Units for logging and loading are specified using Simulink.SimulationData.Unit
objects. When you log using Dataset or Timeseries format, Simulink stores the unit
information using Simulink.SimulationData.Unit objects. If you create MATLAB
timeseries data to load, you can specify Simulink.SimulationData.Unit object for
the Units property of the timeseries object.

For details, see Log Signal Data That Uses Units and Load Signal Data That Uses Units.

New units blocks

The following blocks are new:

*  Unit Conversion

+  Unit System Configuration
Configuration parameters

The following configuration parameters are new, available on the All Parameters tab:
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Allowed unit systems

Unitsinconsistency messages

Allow automatic unit conversions

Model Advisor checks

The following Model Advisor checks are new for units:

Identify undefined units in the model
Identify unit mismatches in the model
Identify disallowed unit systems in the model

Identify automatic unit conversions in the model

Updated example

The Exploring the Solver Jacobian Structure of a Model has been updated with unit
specifications in all components.

Compatibility Considerations

The DocUnits property is now Unit for Simul ink.Parameter or
Simulink.Signal objects. If, in a previous release, you used the DocUnits
parameter of a Simulink.Parameter or Simulink.Signal object to contain text
that does not now comply with units specifications, simulation returns a warning
when the model simulates.

To suppress these warnings, set the configuration parameter Unitsinconsistency
messages to none. This setting suppresses all units inconsistency check warnings.

If you have a class that derives from Simul ink.Parameter, Simulink.Signal, or
Simulink.BusElement with a previously defined Unit property, Simulink returns
an error like the following:

Cannot define property "Unit" in class "classname® because the property
has already been defined in the superclass "superclass”.

If you use this property to represent the physical unit of the signal, delete the Unit
property from the derived class in the R2016a or later release. Existing scripts
continue to work, unless you are assigning incorrectly formed unit expressions to the


http://www.mathworks.com/help/releases/R2016a/simulink/gui/configuration-parameters-on-all-parameters-tab.html#bu4upg7
http://www.mathworks.com/help/releases/R2016a/simulink/gui/configuration-parameters-on-all-parameters-tab.html#bu4upxs-1
http://www.mathworks.com/help/releases/R2016a/simulink/gui/configuration-parameters-on-all-parameters-tab.html#bu4upyj-1
http://www.mathworks.com/help/releases/R2016a/simulink/slref/simulink-checks_bq6d4aa-1.html#bu4thpf
http://www.mathworks.com/help/releases/R2016a/simulink/slref/simulink-checks_bq6d4aa-1.html#bu4thjs
http://www.mathworks.com/help/releases/R2016a/simulink/slref/simulink-checks_bq6d4aa-1.html#bu4thou
http://www.mathworks.com/help/releases/R2016a/simulink/slref/simulink-checks_bq6d4aa-1.html#bu4thoa
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Unit field. In this case, replace the use of Unit with DocUnits to continue to be able
to assign the unit expression.

Note: If you store existing data in a MAT- or .sldd file, in a release prior to R2016a,
copy the contents of the Unit property to the DocUnits first. Then, save the file in
the earlier release before loading the model in R2016a or later release.

Mask Dialogs: Create masks with flexible layout options and new control
parameters

You can use these controls from the Mask Editor dialog box to create a rich mask dialog
box:
* Collapsible panel: Expand or collapse sections in the mask dialog box.

*  Dynamic mask dialogs: Change the menu options of a dependent dialog box based on
the value of the controlling parameter.

*  Spinbox step size: Fine-tune and control a parameter value in the mask dialog box.
* Horizontal stretch property: Create a more flexible mask dialog box layout.

+ Slider and dial parameter: Use variables to specify value in dial and slider
parameters.

For more information, see Mask Editor Overview.
Mask Images: Quickly add images to masks and while keeping the port
names visible

* Mask icons can leave port names visible.

* Mask icon preview is available in the Mask Editor.

For more information, see Mask Editor Overview.

Tracing Simulink Functions: Display connections between all Function
Callers and a Simulink Function
Visually display connections between Simulink functions and their callers with tracing

lines that connect callers to functions:
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*  Turning on/off tracing lines — From the Display menu, select Function
Connectors.

+ Direction of tracing lines — Lines connected at the bottom of a block are from a
function caller. Lines connected at the top of a block are to a Simulink function or a
subsystem containing the function.

+ Navigation to functions — If a function caller is within a subsystem, you can open the
subsystem, and then click a link to the called Simulink function. If the function is at
the root level of a model, the function opens. If the function is within a subsystem, the
subsystem containing the function opens.

Signal Label Propagation for Referenced Models: Propagate signal labels
out of referenced models by default

To propagate signal labels out of referenced models more easily, in R2016a for new
models, the Configuration Parameters > Data Model Referencing > Propagate
all signal labels out of the model parameter is now enabled by default. The default
for the PropagateSignalLabelsOutOfModel parameter is now "on". For details, see
Propagate all signal labels out of the model.

Compatibility Considerations

If you open a model created before R2016a that has the Propagate all signal labels
out of the model parameter cleared, that setting is preserved.

The new default can require updates to scripts written before R2016a that rely on the
previous default PropagateSignalLabelsOutOfModel setting of "ofF". To have
the scripts work as expected with models created in R2016a or later, update the code to
reflect that the default for that parameter is now "on”.

Simulink.SubSystem.convertToMode IReference function for
multiple subsystem conversion: Convert multiple subsystems with one
command

You can convert multiple subsystems in a model to referenced models in one
Simulink.SubSystem.convertToModelReference command.
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Subsystem to Model Reference Conversion: Insert subsystem wrapper to
preserve model layout

When you convert a subsystem to a referenced model, you can have the conversion
process insert a wrapper subsystem to preserve the layout of a model. The subsystem
wrapper contains the Model block from the conversion.

In the Model Reference Conversion Advisor, enable the Create a wrapper subsystem
input parameter. In the Simulink.SubSystem.convertToModelReference function,
use the CreateWrapperSubsystem name and value pair.

Model Reference Conversion Automatic Fix for Goto Blocks: Convert
subsystems with Goto blocks more easily

The Model Reference Conversion Advisor and the
Simulink.SubSystem.convertToMode lReference function include additional
checks and automatic fixes to make it easier to convert subsystems with Goto blocks to
referenced models.

Virtual Bus Signals Across Model Reference Boundaries: Use virtual bus
signals as inputs or outputs of a referenced model

In R2016a, when you specify that a bus signal input or output for a referenced model is a
virtual bus, Simulink sets up the model so that, compared to previous releases, generated
code generally:

+ Has fewer copies of bus signals

+  Executes faster

Use the Block Parameters dialog box for an Inport or Outport block to specify virtual bus
output.

* Inport block — Clear the Output as virtual bus parameter.
*  Outport block — Clear the Output as virtual bus in parent model parameter.
For information about the changes to the code that you generate from models, see Model

Block Virtual Buses: Interface to Model blocks by using virtual buses, reducing data
copies in the generated code.
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Compatibility Considerations

The behavior of models that meet these criteria is different than it is in R2016a:

* The model was saved in a release earlier than R2016a.

*  The model has referenced models with bus inputs and outputs configured to be
treated as virtual buses.

Use the Upgrade Advisor Check for virtual bus across model reference boundaries check
to avoid errors that the new behavior can trigger. Run the Analyze model hierarchy
and continue upgrade sequence check on the top-level model and then down through
the model reference hierarchy.

Bus Selector and Bus Assignment Block Signals: Display full signal path
while editing a model

You can now display full paths to bus signals for Bus Selector and Bus Assignment
blocks in the Simulink Editor, without opening the Block Parameters dialog boxes for
the blocks. Interactively viewing the full signal path can simplify the process of editing
signals with duplicate leaf names, by eliminating the need to match the block ports with
the associated signals. Also, interactively viewing the full path for the signal provides a
quick way to get context for understanding the model.

* To see the full path of a Bus Selector block output signal, hover over the output signal
label.

* To see the full path of up to the first ten output signals of a Bus Selector block, hover
over the block.

* To see the full path of up to the first ten signals in a Bus Assignment block, hover
over the block.

Multi-Input Bus-Capable Block Ports: Simulate unconnected multi-input
bus-capable block ports without error

Before R2016a, simulating a model that contains a multiport bus-capable block with an
unconnected input port causes an error if one or more of the input ports is connected
directly to either:

* A bus signal
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* A Ground block

In R20164a, you can simulate under the same circumstances without error for these
multiport bus-capable blocks:

*  Manual Switch

*  Multiport Switch

* S-Function

*  Switch

* Variant Source

* Vector Concatenate

Using a Merge block in Simplified initialization mode in still causes an error for those
situations.

Outport Blocks with Bus Output: Simulate Outport blocks with a bus
output without error

Before R2016a, simulating a model that contains an Outport block whose output data
type is specified by a bus object caused an error if either of these conditions applied:

* The Outport block has an unconnected port.

*  The Outport block is connected directly to a Ground block.

In R20164a, you can simulate without error in these situations.

Function-Call Split block with multiple outputs
Before R2016a, the Function-Call Split block was a circular block with one input and two

outputs. In R2016a, this block can split an incoming function-call signal into more than
two output signals. You can also change the shape of the block.

Function-Call Split block with no input signal
Before R2016a, the Function-Call Split block had to have an input signal. In R2016a, you

can simulate your model without supplying an input signal to the Function-Call Split
block.
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Trigger port with inherited periodic function-call signal

Before R20164a, if the Trigger block of a triggered subsystem had the Trigger type
parameter set to Function-call and Sample time type set to periodic, you could
not set Sample time to -1. In R2016a, you can specify a sample time of -1.

Standalone code generation for models with asynchronous function-call
inputs

Before R2016a, you had to build a top model from which to reference asynchronous
function-call inputs. In R2016a, models with asynchronous function-call inputs support
code generation on standalone models. You can now build these models as is.

Additional component parameters saved with
Simulink.ConfigSet.saveAs

In R20164a, the Simulink.ConFigSet.saveAs function saves all enabled parameters
in the base configuration set. In addition, the function saves enabled parameters for the
following components:

* Coder Target

* HDL Coder™

Polyspace®

SimEvents®

+  Simscape™

+  Simulink Coverage

*  Simulink Design Verifier™
*  Simulink PLC Coder™

* Target Hardware Resources
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Start Page: Get started or resume work faster by accessing templates,
recent models, and featured examples

The Simulink start page helps you get started faster by offering model and project
templates and examples. You can use common design patterns or learn about new

features.

If you want to pick up where you left off, the start page shows a list of recent models, and
opens the project automatically if your selected model is part of a project. You can now
also open recent models from the Simulink Editor or from the Library Browser.

For details, see Create Models and Open Existing Models, or watch this video to learn

more.

Compatibility Considerations

In previous releases, you could not access a list of recent models, and you could not find
model and project templates and examples in the same place. The Simulink Template
Gallery and the project template browser are merged into the start page.

Functionality

What Happens When You Use
This Functionality?

Compatibility Considerations

simulink

Opens the start page

simulink no longer opens the
Library Browser, but instead
opens the start page.

To open the Library Browser,
use slLibraryBrowser
instead, or click the Library
Browser button in the

5[
Editor: | HE |

i)

Simulink

Opens the start page

The Simulink button in
MATLAB no longer opens
the Library Browser, but
instead opens the start page.
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Functionality

What Happens When You Use
This Functionality?

Compatibility Considerations

Simulink button on the
MATLAB Home tab.

Creating a new model,
chart, library, or project
from the MATLAB Home
tab New menu, from the
Editor, from the Library
Browser, or from Simulink
Project.

Opens the start page

Choose a template from

the start page. The start
page shows an appropriate
filtered list of models, charts,
libraries, or projects.

To recreate the previous
workflow:

* In the start page, select
Blank Model, Blank
Library, Blank Project, or
Chart, (or press Ctrl+N
for a blank model),

* In the Editor or Library
Browser, select a new
Blank Model (or press
Ctrl+N).

To create a project using
source control or from an
archive, use the start page
options.
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Functionality

What Happens When You Use
This Functionality?

Compatibility Considerations

Use model templates.

Find all your templates on
the start page.

The menu item From
Template is no longer in the
Editor or Library Browser.
Instead, in the Simulink
Editor, select File > New

> Model and select your
template in the start page.
In the Library Browser,

click the New Model button
arrow and select Model. The
Simulink Template Gallery
1s now merged into the start

page.

Use project templates.

Find all your templates on
the start page.

Project templates are no
longer in the MATLAB Home
tab New menu or in the
Create Project dialog box.
Instead, open the start page
from MATLAB, or from the
Editor by selecting File >
New > Project, and select
your template in the start

page.

Simulink project templates
created in R2014a or earlier
(-zip files)

You cannot browse to legacy
templates in the start page

Upgrade legacy templates
to .sltx files using
Simulink.exportToTemplate.

Automatic Renaming: Update all references in a project when you
rename models, libraries, or MATLAB files

In a Simulink project, when you rename, delete, or remove a file, the project checks for
impact in other project files. You can find and fix impacts such as changed library links,
model references, and model callbacks. This tooling can help you avoid refactoring pain
tracking down other affected files. Automatic renaming is helpful in preventing errors
that result if you change names or paths manually and overlook or mistype one or more

instances of the name.
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Automatic renaming helps you refactor MATLAB code. Simulink project dependency
analysis now finds dependencies on MATLAB code in packaged functions, classes, and
superclasses. You can view the dependencies in the Impact graph and if you refactor the
files, automatic renaming prompts you. For example, when renaming a class, the project
offers to automatically update all classes that inherit from it. If you rename a .m or -mlIx
file, the project offers to automatically update any files and callbacks that call it.

For details, see Automatic Updates When Renaming, Deleting, or Removing Files.

Three-Way Model Merge: Resolve conflicts between revisions and
ancestor models using Simulink projects

In a Simulink project under source control, if your changes in a model conflict with
another user, you can open the Three-Way Model Merge tool to resolve the conflicts. You
can examine your local file compared to the conflicting revision and the base ancestor file,
and decide which changes to keep. You can resolve the conflict and submit your changes.
Three-Way Model Merge requires Simulink Report Generator™.

For details, see Resolve Conflicts.

Template API: Programmatically create models and projects from custom
templates

In R2016a, you can programmatically create models and projects from templates, and
create custom templates. Model and project templates are starting points to apply
common modeling approaches. They help you reuse settings and block configurations
and share knowledge. Use model and project templates to apply best practices and take
advantage of previous modeling solutions.

To use templates programmatically, see Simulink.createFromTemplate,
Simulink.findTemplates, and Simulink.exportToTemplate.

Export function: Export to previous version using
Simulink.exportToVersion

In R2016a you can use a new function, Simulink.exportToVersion, to export a model so
that you can open it in a previous version of Simulink. The new function makes it easier
to distinguish between exporting to a previous version and saving with a different name.
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In previous releases you could use save _system with the "ExportToVersion® option.
This option will also continue to work.

Dirty Model Management: Identify, save, or discard unsaved changes in
project models

In a Simulink project, you can check for unsaved changes in project models, and decide
whether to save or discard changes. In the previous release, you had to close the project
to see warnings about unsaved changes. Now you can manage unsaved changes before
closing the project.

For details, see Manage Shadowed and Dirty Model Files.

Source Control API: Programmatically get modified files and revision
information

In R20164a, you can programmatically get source control status information about
Simulink project files. Use simul inkproject to get a project object, then you can get
a list of modified files in the project. You can get the local status of a file (modified,
unmodified, not under source control) and the revision if available.

For details, see listModifiedFiles.

Source Control Notifications: List changed files on update (SVN); find out
if your branch is behind the origin (Git)

In R2016a, Simulink Project provides more notifications to help you with source control
operations. With SVN, when you update a project from the repository, you see a list of all
changed files in a dialog box. With Git, when you fetch from a remote repository, you can
see 1f your current branch is behind or ahead of the remote tracking branch (the origin).

For details, see Update Revisions with SVN and Fetch and Merge.

SVN Externals: Include files in projects from other repositories or
repository locations
Use SVN externals to get files into your Simulink project from another repository or from

a different part of the same repository. Right-click a project folder and select Manage
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SVN Externals. The project provides a dialog to help you browse, specify and validate
the externals definitions. After you define the externals setting on a folder, other project
users can get the same files included in their project.

For details, see Manage SVN Externals.

Custom Shortcut Icons: Personalize frequent task buttons on the toolstrip

In R20164a, you can specify an icon to use for your shortcut buttons on the Project
Shortcuts tab. Icons such as “build” can aid other project users to recognize frequent
tasks. For details, see Customize Shortcut Icons.

Simplified Configuration Parameters: Configure model more easily using
streamlined category panes

In the Configuration Parameters dialog box, streamlined category panes display only
configuration parameters that you are most likely to use when configuring your model.

The category panes, previously referred to as the Category view, are now available on the
Commonly Used Parameters tab. The All Parameters tab, previously referred to as
the List view, provides the complete list of parameters in the model configuration set.

% Configuration Parameters: vdp/Configuration (Active) EI@
* Commonly Used Parameters | = All Parameters
Select: Simulation time
Salver Start time: 0.0 Stop time: 20
Data Import/Export
 Optimization Solver options
» Diagnostics
Hardware Implementation Type: |Variable-step 'l Saolver: |0de45 (Dormand-Prince) A
Model Referencing
Simulation Target » Additional options

2-18

+ Code Generation

Compatibility Considerations

Following are the configuration parameters that have moved to the All Parameters tab
or moved to a different pane.
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Note: Parameters that are removed from a pane are still available for configuration on
the All Parameters tab. To locate a parameter on this tab, use either the search box or
the Category filter.

Data Import/Export Pane

The Enable live streaming of selected signal to Simulation Data Inspector
parameter is moved to the All Parameters tab.

The Save simulation output as single object parameter is now called Single
simulation output

The following parameters are available by clicking Additional Parameters at the
bottom of the pane:

* Limit data points to last

* Decimation

* Output options

* Refine factor
Diagnostics Pane

The following parameter is moved to the All Parameters tab:

* Solver data inconsistency
Diagnostics > Data Validity Pane

The following parameters are moved to the All Parameters tab:

+ Array bounds exceeded

+ Model verification block enabling

+ Check preactivation output of execution context

+ Check runtime output of execution context

+ Check undefined subsystem initial output

* Detect multiple driving blocks executing at the same time step

+ Underspecified initialization detection
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Diagnostics > Saving Pane
The pane is removed and its parameters are moved to the All Parameters tab:

* Block diagram contains disabled library links

* Block diagram contains parameterized library links
Diagnostics > Solver Pane

The following parameters are moved to the Diagnostics > Sample Time pane:

* Sample hit time adjusting

* Unspecified inheritability of sample time

The following parameter is moved to the Diagnostics > Compatibility pane:
+ SimState object from earlier release

Optimization Pane

The following parameters are moved to the All Parameters tab:

* Remove code from floating-point to integer conversions with saturation that
maps NaN to zero

+ Compiler optimization level

* Verbose accelerator builds

+ Implement logic signals as Boolean data (vs. double)

* Block reduction

+ Conditional input branch execution

+ Use memset to initialize floats and doubles to 0.0
Optimization > Signals and Parameters Pane

The following parameters are moved to the All Parameters tab:

+ Signal storage reuse
* Enable local block outputs
* Reuse local block outputs

+ Optimize global data access
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* Reuse global block outputs
+ Eliminate superfluous local variables (Expression folding)

+  Simplify array indexing
Simulation Target Pane
The following parameters are moved to the All Parameters tab:

+ Echo expressions without semicolons

* Simulation target build mode

* Ensure responsiveness

* Generate typedefs for imported bus and enumeration types

* Ensure memory integrity
Simulation Target > Custom Code Pane

The pane is removed and its parameters are moved to the Simulation Target pane:

* Header file

+ Initialize function

* Source file

* Terminate function

* Parse custom code symbols
* Include directories

* Libraries

* Source files

* Defines
Simulation Target > Symbols Pane
The pane is removed and its parameter is moved to the Simulation Target pane:

+ Reserved names
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Single-Selection Actions: Access commonly used editing actions when
clicking a block or signal line

When you select a block or a signal line in a Simulink model, a cue appears that lets you
select a common action to perform. When you move your cursor over the cue, an action
bar appears. Click the action you want to perform.

*  For blocks, you can comment or uncomment the block or hide or display the block
name using this cue.

*  For signal lines, you can autoroute the line or enable or disable signal logging.

The figure shows how to use the cue to comment out a block.

1k —

_FD
’_’ Mu ’_’ Mu
Rl %

Watch this video to learn more.

Multiple-Selection Cue: Selecting multiple blocks in the Simulink Editor
shows new cue

When you select multiple blocks in your model, the Simulink Editor now displays a
smaller cue, as shown in the figure. Move your mouse over the cue to display the action
bar of common commands.


https://www.mathworks.com/videos/single-selection-actions-116252.html
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Single Click for Quick Insert: Click block name once to insert block from
list

If you know the name of the block you want to add to a model, you can click in the model
where you want to add the block and start typing the block name. The blocks that match
appear in a list. In previous releases, you double-clicked the block name to insert it in
the model. In R2016a, you click the block name once to insert it. For an example, see Add
More Blocks.

Interactive Library Unlocking: Click lock symbol in custom libraries to
unlock

Clicking the lock symbol in a custom library now unlocks the library so you can edit it.
For information about library locks, see Create a Custom Library.

Key Parameter Preference: Turn off parameter prompt during block creationWhen you
add a block to a model, a prompt appears so that you can enter a key parameter. To
prevent this prompt from appearing, you can set a preference. In your model, select
FileSimulink Preferences. In the Editor Preferences pane, clear the Edit key parameter
when adding new blocks check box.

Improved block search usability

The Quick Block Insert search displays a description of the library making it easier to
recognize the block in the Library Browser.
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Signal and State Logging to File: Log data directly to a MAT-file for long
simulations

When logging large amounts of data that can cause memory issues for a long simulation,
use the new Configuration Parameters > Data Import/Export > Log Dataset data
to file parameter. With this feature enabled, Simulink stores in a MAT-file data that is
in Dataset format for these kinds of logging:

* Signal logging
+  States

+ Final states

* Output

* Data stores

Alternatively, you can enable this feature using the LoggingToFile and
LoggingFileName name-value pairs with either the sim command or set_param
command.

Using a Simulink.SimlationData.DatasetRef object to access signal logging and
states logging data loads data into the model workspace incrementally. Loading and
accessing data for other kinds of logging loads all of the data into memory at once.

For details, see Log Data Using Persistent Storage.

Preserve symbolic constants in propagated signal dimensions

Previously, Simulink treated signal and parameter dimension specifications as numeric
constants. In R2016a, you can use a Simul ink_Parameter object as a symbol in a
MATLAB expression to represent a dimension value. During simulation, Simulink
propagates dimension symbols throughout the model and preserves these symbols in the
propagated signal dimensions.

For example, Inport blocks Inl and In2 have symbolic constant dimension specifications.
In the Signals Attribute tab in the Source Block Parameters dialog box for Inl, the
Port dimension parameter has the Simul ink.Parameter A, which has a value of 2.

In the Signals Attribute tab in the Source Block Parameters dialog box for In2, the
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Port dimension parameter has the Simul ink.Parameter B, which has a value of 3.
When you simulate the model, you see the symbolic constants and their values propagate
throughout the model.
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Embedded Coder preserves these dimension symbols and expressions in the generated
code. If you use Embedded Coder, you can compile the same generated code into multiple
applications of different sizes. For more information on generating code with symbolic
constants, see Compile-Time Dimensions: Generate compiler directives (#define) for
implementing signal dimensions and Implement Dimension Variants for Array Sizes in
Generated Code.

Dataset Format for Signal Logging: Log signals in format used for other
logging

When you open a model in R2016a, signal logging uses the Dataset format for the
logged data. The SignalLoggingSaveFormat parameter is set to Dataset.

Dataset is the default format for logging output and state information. Using the same
format for signal logging data as well as other logged data simplifies writing scripts to
process that data.

Compatibility Considerations

The Mode IDatal ogs class is supported for backwards compatibility. Starting in R2016a,
you cannot log data in the Mode IDatalogs format. In R2016a or later, when you open

a model from an earlier release that had used ModelDatalogs format, the model is
converted to use Dataset format.
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You can convert signal logging data from Mode IDatalLogs to Dataset format. For more
information, see Convert Logged Data to Dataset Format.

If you have legacy code that uses the Simul ink_.ModelDatalLogs API, you can

encounter situations that require updates to your code or model. See Migrate Scripts
That Use ModelDatal.ogs API.

Unlimited Number of Data Points for Logging by Default: Log all data
points by default

To simplify logging time, output, and state data, the default behavior is to have no limit
on the number of data points logged during a simulation. In R2016a, by default the
Configuration Parameters > All Parameters > Limit data points is now cleared.

Compatibility Considerations

The changed default can require updates to scripts written before R2016a that rely on
the previous default of limiting the logged data points to 1000 or to a specified number of
data points and that use:

+ The new_system function to create an empty Simulink system
+ Simulink.ConfigSet to access the model configuration set

Root Inport Mapping Tool Updates
The Root Inport Mapping Tool has the following updates:

+ New interface

Support for Excel® spreadsheets on all platforms

*  Support for the linking in of multiple scenario files at the same time

For more information, see Map Root Inport Signal Data

Function to convert MAT-file contents to
Simulink.SimulationData.Dataset object

New convertToSIDataset function converts the contents of a MAT-file that contains
Simulink inputs to a Simulink.SimulationData.Dataset object.
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Data Management

Functions to identify and close data dictionaries

Some commands and functions, such as
Simulink.data.dictionary.cleanupWorkerCache, cannot

operate when data dictionaries are open. Use the new function
Simulink.data.dictionary.getOpenDictionaryPaths to identify open data dictionaries.

You can use the new function Simulink.data.dictionary.closeAll to close all connections
to all open data dictionaries. However, it is a best practice to close each individual
connection.

Navigation to variables from additional block dialog boxes

Beginning in R2015a, you can navigate to or create variables directly from blocks in
the base Simulink libraries such as Discrete and Continuous. You can navigate to or
create the variables in a workspace or data dictionary, or navigate to mask parameters,
by right-clicking the variable name in the block dialog box. For more information, see
Manage Variables from Block Parameter.

In R20164a, the blocks in these additional libraries allow you to navigate to variables from
block dialog boxes:

Communications System Toolbox

Communications System Toolbox Support Package for RTL-SDR Radio,
except for the Radio address parameter in the RTL-SDR Receiver block

Communications System Toolbox Support Package for Xilinx FPGA-Based
Radio

SimEvents, except for the Port number parameter in the Conn legacy block
Simulink Coder

Simulink Control Design

Simulink Design Optimization

Simulink Design Verifier

Simulink Extras

Simulink Support Package for Apple iOS Devices

Simulink Support Package for BealgeBoard Hardware

Simulink Support Package for LEGO MINDSTORMS EV3 Hardware
Simulink Support Package for LEGO MINDSTORMS NXT Hardware
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*  Simulink Support Package for Raspberry Pi Hardware

+  Simulink Support Package for Samsung GALAXY Android Devices

+ System Identification Toolbox

Functionality Being Removed or Changed

Functionality

Result

Use Instead

Compatibility
Considerations

The programmatic
parameter
DefaultDataPackage,
which corresponds

to the Package

option on the Data
Management
Defaults pane in the
Simulink Preferences
dialog box.

Warning. For example,
this command generates a
warning:

set_param(O, - - .
"DefaultDataPackage”®, . - .

"mpt")

To select default
classes for
creating signal
and parameter
objects, on the
Model Explorer
toolbar, click the
arrows next to the
Simulink Signal
and Simulink
Parameter buttons.

To select a default
package when you
apply a custom
storage class in a
Signal Properties
dialog box or in a
block dialog box,
use the new drop-
down list Signal
object class.

In the Data Object
Wizard, click
Change Class to
select a class for
each data object
that the wizard
proposes.

In your scripts,

remove references

to the programmatic
parameter
DefaultDataPackage.
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Connection to Hardware

Connection to Hardware

Hardware implementation parameters enabled by default
In R2016a, the Enable hardware specification button is removed from the

Configuration Parameters > Hardware Implementation pane. By default, the
parameters on the pane are enabled.

Mac Support for LEGO EV3: Run Simulink models on LEGO EV3
hardware from a Mac

You can use the Simulink Support Package for LEGO® MINDSTORMS® EV3 Hardware
on the Apple Mac OS X platform.
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From Spreadsheet Block Updates
The From Spreadsheet has the following changes:

* The block has moved from the Simulink Extras/Additional Sources sublibrary to the
Simulink Sources sublibrary.

* The block now supports Rapid Accelerator mode on all platforms.

System object enhancements to MATLAB System block

To implement these classes and methods for defining your own System objects, add them
to your object's class definition file.

+ Fixed-point data tab — The showFiSettingsImpl method adds a Data Types tab to
the MATLAB System block dialog box. This tab includes options for fixed-point data
settings.

*  Model reference discrete sample time inheritance — The
allowModelReferenceDiscreteSampleTimeInheritanceImpl method lets you specify
whether a System object in a referenced model can inherit the sample time of the
parent model. If your object uses discrete sample time in its algorithm, you set this
method to true to allow inheritance.

Unit Delay block does not accept rate transitions

In R20164, if the Unit Delay block input and output signals are at different rates, the
block produces an error. For the rate transitions workflow, use a Rate Transition block.

Matrix Interpolation Block for Multidimensional Lookup Table Data

The Matrix Interpolation block performs interpolation (or extrapolation) on a
multidimensional table, where each data point can be a matrix. The block resides in the
Simulink Extras library.

Enhanced System Object Development with MATLAB Editor

Create System objects in the MATLAB Editor using code insertion and visualization
options.
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Block Enhancements

+ Define your System object with options to insert properties, methods, states, inputs,
and outputs.

* View and navigate the System object code with the Analyzer.

*  Develop System block and preview block dialog box interactively (with Simulink only).

~ Comment 9 ‘e ] {F Input / Output ~
A System | Br

r indent x| &z |5 Property = Method = . Analyze Block
EDIT 5% 5TEM OBJECT RE

nsert 51 fx - @I % 5, Insert State
Insert Insert

These coding tools are available when you open an existing System object or create a new
System object with New > System object.

Scope Block and Signal Viewer Enhancements

+ Added ability to select signals for individual displays. This change removes an
incapability from previous releases. See Connect Signals to Floating Scope Block or
Scope Viewer

+  Expand scope window layout from 4 x 4 to 16 x 16 displays. See Select Number of
Displays and Layout.
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Cell Array Support: Use additional cell array features in @ MATLAB
Function block

In R2016a, support for cell arrays in a MATLAB Function block includes:
Use of {end + 1} to grow a cell array

You can write code such as X{end + 1} to grow a cell array X. For example:

X = {1 2};
X(end + 1} = "a";

When you use {end + 1} to grow a cell array, follow the restrictions described in
Growing a Cell Array by Using {end + 1}.

Value and handle objects in cell arrays

Cell arrays can contain value and handle objects. You can use a cell array of objects as a
workaround for the limitation that code generation does not support objects in matrices
or structures.

Function handles in cell arrays

Cell arrays can contain function handles.

Non-Power-of-Two FFT Support: Generate code for fast Fourier
transforms for non-power-of-two transform lengths

In previous releases, code generation required a power of two transform length for fft,
fft2, fftn, ifft, ifft2, and ifftn. In R20164a, code generation allows a non-power-of-two
length for these functions.

Faster Standalone Code for Linear Algebra: Generate code that takes
advantage of your own target-specific LAPACK library

To improve the simulation speed of MATLAB Function block algorithms that call certain
linear algebra functions, the simulation software can call LAPACK functions. In R2016a,
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if you use Simulink Coder to generate C/C++ code for these algorithms, you can specify
that the code generator produce LAPACK function calls. If you specify that you want to
generate LAPACK function calls, and the input arrays for the linear algebra functions

meet certain criteria, the code generator produces calls to relevant LAPACK functions.
The code generator uses the LAPACKE C interface.

LAPACK is a software library for numerical linear algebra. MATLAB uses this library
in some linear algebra functions, such as eig and svd. Simulink uses the LAPACK
library that is included with MATLAB. Simulink Coder uses the LAPACK library that
you specify. If you do not specify a LAPACK library, the code generator produces code for
the linear algebra function instead of generating a LAPACK call.

See LAPACK Calls for Linear Algebra in a MATLAB Function Block.

To specify that you want to generate LAPACK function calls and link to a specific
LAPACK library, see Speed Up Linear Algebra in Code Generated from a MATLAB
Function Block in the Simulink Coder documentation.

Concatenation of variable-size, empty arrays

In R2016a, the MATLAB Function block treatment of an empty array in a concatenation
more closely matches the MATLAB treatment.

For concatenation of arrays, MATLAB and the MATLAB Function block require that
corresponding dimensions across component arrays have the same size, except for the
dimension that grows. For horizontal concatenation, the second dimension grows. For
vertical concatenation, the first dimension grows.

In MATLAB, when a component array is empty, the sizes of the nongrowing dimensions
do not matter because MATLAB ignores empty arrays in a concatenation. In previous
releases, the MATLAB Function block required that the sizes of nongrowing dimensions
of an variable-size, empty array matched the sizes of the corresponding dimensions in the
other component arrays. A dimension size mismatch resulted in a simulation error.

In R2016a, for most cases of empty arrays in concatenation, the MATLAB Function block
behavior matches MATLAB behavior. In some cases, if the MATLAB Function block does

not recognize the empty array and treats it as a variable-size array, a dimension size
mismatch results in a simulation error.

Consider the function myconcat that concatenates two arrays A and B.
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function D = myconcat(n, B)
%#codegen

assert(n <= 5);

A = zeros(n,3);

C = [A, B];

D = numel(C);

end

The size of A is :5-by-3. The first dimension has a variable size with an upper bound of
5. The second dimension has fixed size 3. Suppose that B is a 5-by-5 array. If ni1s 0, A

is an empty array whose size is 0-by-3. In previous releases, myconcat in a MATLAB
Function block resulted in a size mismatch error because the size of dimension 1 of A
did not match the size of dimension 1 of B. In R2016a, in a MATLAB Function block, the
output from myconcat is 25. This output is the same as the output from myconcat in
MATLAB.

Compatibility Considerations

When the result of the concatenation is assigned to a variable that must be a fixed-
size variable, support for a variable-size, empty array in a concatenation introduces an
incompatibility.

In previous releases, it was possible that a concatenation that included a variable-

size array produced a fixed-size array because concatenation rules were stricter in the
MATLAB Function block than in MATLAB. In R2016a, a concatenation that includes a
variable-size array produces a variable-size array. If the result of the concatenation is
assigned to a variable that must be a fixed-size variable, an error occurs.

Consider the function myconcatl that concatenates two arrays X and Y.

function ¢ = myconcatl(n, Y)
%#codegen

assert(n <= 2);

X = zeros(n,2);

Z.f = [XY];

c = numel(Z.F);

X has size :2-by-2. The first dimension has a variable size with an upper bound of 2. The
second dimension has fixed size 2. Suppose that Y is a 2-by-4 array. In previous releases,
the MATLAB Function block determined that the result of [X Y] had fixed size 2-by-6.
In R2016a, the result of [X Y] has a size of 2-by-:6. The first dimension has a fixed size
of 2 and the second dimension has a variable size with an upper bound of 6. This size
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accommodates an empty and nonempty X. If X is empty, the size of the result is 2-by-4. If
X is nonempty, the size of the result is 2-by-6.

Consider the function myconcat2.

function ¢ = myconcat2(n, Y)
%#codegen

assert(n <= 2);

X = zeros(n,2);

Z.f = ones(2,6);

myfcn(2);

Z.f=[XY];

c = numel(Z.%);

function myfcn(~)

myconcat?2 assigns a 2-by-6 value to Z.F. The size of Z. F is fixed at 2-by-6 because Z is
passed to myfcn. The result of the concatenation [X Y] is variable-size. The assignment
Z.F¥ = [X Y] results in an error because the left side of the assignment is fixed-size and
the right side is variable-size.

To work around this incompatibility, you can use coder .varsize to declare that Z.f is
variable-size.

function ¢ = myconcat2(n, Y)
%#codegen

assert(n <= 2);
coder.varsize("Z.f");

X = zeros(n,2);

Z.f = ones(2,6);

myfcn(2);

Z.f = [XY];

c = numel(Z.%);

function myfcn(~)

xcorr Code Generation: Generate faster code for xcorr with long input
vectors

For long input vectors, code generation for xcorr now uses a frequency-domain calculation

instead of a time-domain calculation. The resulting code can be faster than in previous
releases.
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To use the xcorr function, you must have the Signal Processing Toolbox™ software.

More keyboard shortcuts for the MATLAB Function report

In R2016a, you can use keyboard shortcuts to perform the following actions in a

MATLAB Function report.

Action Default Keyboard Shortcut
Zoom in Ctrl+Plus
Zoom out Ctrl+Minus
Evaluate selected MATLAB code F9

Open help for selected MATLAB code F1

Open selected MATLAB code Ctrl+D

Step backward through files that you Alt+Left
opened in the code pane

Step forward through files that you opened |Alt+Right
in the code pane

Refresh F5

Find Ctrl+F

Your MATLAB preferences define the keyboard shortcuts associated with these actions.
You can also select these actions from a context menu. To open the context menu, right-

click anywhere in the report.
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Zoom In Ctrl+Plus

Zoom COut Ctrl+Minus

Evaluate Selection F9
Help on Selection F1
Open Selection Ctrl+D

Back Alt+Left
Forward Alt+Right
Refresh s

Find... Ctrl+F

Page Source

Code generation for Audio System Toolbox functions and System objects

See Audio System Toolbox in Functions and Objects Supported for C and C++ Code
Generation — Category List.

Code generation for additional Computer Vision System Toolbox functions
and objects

See C code generation support in the Computer Vision System Toolbox™ release notes.

Image Processing Toolbox Code Generation: Generate code for additional
functions

See C-code generation support for more than 20 functions, including regionprops,
watershed, bweuler, bwlabel, bwperim, and multithresh using MATLAB Coder in the
Image Processing Toolbox™ release notes.

2-37


http://www.mathworks.com/help/releases/R2016a/simulink/ug/functions-supported-for-code-generation--categorical-list.html#bu7z81n
http://www.mathworks.com/help/releases/R2016a/simulink/ug/functions-supported-for-code-generation--categorical-list.html
http://www.mathworks.com/help/releases/R2016a/simulink/ug/functions-supported-for-code-generation--categorical-list.html
http://www.mathworks.com/help/releases/R2016a/vision/release-notes.html#bu1fkvt-15
http://www.mathworks.com/help/releases/R2016a/images/release-notes.html#bumt6p2-5
http://www.mathworks.com/help/releases/R2016a/images/release-notes.html#bumt6p2-5

R2016a

2-38

Code generation for additional MATLAB functions
Specialized Math in MATLAB

* airy
* besseli

* besselj

See Specialized Math in MATLAB in Functions and Objects Supported for C and C++
Code Generation — Category List.

Trigonometry in MATLAB

* deg2rad
* rad2deg

See Trigonometry in MATLAB in Functions and Objects Supported for C and C++ Code
Generation — Category List.

Interpolation and Computational Geometry in MATLAB

* interpn

See Interpolation and Computational Geometry in MATLAB in Functions and Objects
Supported for C and C++ Code Generation — Category List.

Changes to code generation support for MATLAB functions

*  Code generation now supports the nanflag option for sum, mean, median, min,
max, cov, var, and std.

*  Code generation for ismember no longer requires that the second input be sorted.

See Functions and Objects Supported for C and C++ Code Generation — Alphabetical
List.

Code generation for additional Communications System Toolbox functions

* convenc
*  dpskdemod
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dpskmod
gammod
gamdemod

vitdec

See Communications System Toolbox in Functions and Objects Supported for C and C++
Code Generation — Category List.

Code generation for additional DSP System Toolbox

audioDeviceWriter
dsp.Differentiator
designMultirateFIR
dsp.SubbandAnalysisFilter
dsp.SubbandSynthesisFilter

DSP System Toolbox in Functions and Objects Supported for C and C++ Code Generation
— Category List.

Code generation for additional Phased Array System Toolbox functions

fogpl

gaspl

rainpl
phased.BackscatterRadarTarget
phased. LOSChannel
phased.WidebandLOSChannel

See Phased Array System Toolbox in Functions and Objects Supported for C and C++
Code Generation — Category List.

Code generation for WLAN System Toolbox functions and System objects

See WLAN System Toolbox in Functions and Objects Supported for C and C++ Code
Generation — Category List
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Units for MATLAB Function blocks

Simulink supports the specification of a unit property for data inputs and outputs of
MATLAB Function blocks. Specify units for input and output data by using the Unit
(e.g., m, m/s*2, N*m) parameter on the Ports and Data Manager.

During model update, Simulink checks for inconsistencies in units between input and
output data ports and the corresponding Simulink signals.

In/Out Arguments: Specify same variable name for in/out arguments

In a MATLAB Function block, you can specify the same name for input and output
arguments. For example, the block supports this code.

function y = fcn(y)
%#codegen

y =y +1;
The corresponding input and output ports on the block have the same name, y.

UserData parameter available for storing values

Use set_param() and get_param() to store and retrieve values in the UserData
parameter for MATLAB Function blocks.



Modeling Guidelines

Modeling Guidelines

High-Integrity Systems: Model object, file, and folder names

When you develop models for high-integrity systems, use the following guidelines for
model object, file, and folder names:

hisl 0031: File and folder names
hisl_0032: Model object names

If you have a Simulink Verification and Validation™ license, you can use the following
Model Advisor standards checks to verify compliance with high-integrity guideline
hisl_0032: Model object names. The checks are available in the applicable Model Advisor
By Task folder.

DO-178C/D0O-331: Check model object names
IEC 61508, EN 50128 and ISO® 26262: Check model object names
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Model Advisor

Additional functionality for Model Advisor check that checks for usage of
partial structure

In R2016a, the Model Advisor check Check for partial structure
parameter usage with bus signals has a new name, Check structure
parameter usage with bus signals. The check uses a new programmatic ID,
mathworks .design._MismatchedBusParams.

If you have Simulink Coder software, before you generate code from a model, use this
check to discover potential inefficient typecasts due to mismatched data types. For
information about the changes to the check functionality, see Model Advisor check for
data type mismatches between bus elements and structure fields.

Compatibility Considerations

If you have scripts that programmatically run this check, consider

using the new programmatic ID. The old programmatic ID is
mathworks.design.PartialBusParams. For example, your scripts might use this
command:

SysResultObjArray = ModelAdvisor.run({"myModel"},{"mathworks.design.PartialBusParams”}

Your scripts continue to work with the old ID. The new ID is
mathworks.design.MismatchedBusParams.

In a future release, the check will appear in the By Product > Simulink Coder folder
instead of the By Product > Simulink folder. You will need Simulink Coder software to
run the check. If you do not have Simulink Coder software, consider removing the check
from your scripts in R2016a.
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S-Functions

ssSetSolverNeedsReset updates

The ssSetSolverNeedsReset macro is now needed for both fixed-step and variable-step
ODE solvers. Simulink now monitors S-function continuous state changes without solver
resets in normal and accelerated simulation modes for fixed-step simulation.

To improve performance, consider updating existing S-functions that correctly use
ssSetSolverNeedsReset with the new macro, ssSetSkipContStatesConsistencyCheck.

ssSetSkipContStatesConsistencyCheck

The ssSetSkipContStatesConsistencyCheck macro is a new macro that lets you skip
continuous state consistency checks. Consider using this macro for an S-function with
continuous states that either does not change the state vector or changes it only in
conjunction with ssSetSolverNeedsReset.
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Simulink Editor

Signal Line Healing: Click once to repair broken signal lines after deleting

blocks

You can connect signal lines that broke when you deleted a block. When you delete a
block that was connected to one input signal and one output signal, a prompt appears in
its place. Click the prompt to connect the broken input and output signal lines to each
other.

>
>

Multilingual Names and Comments: Use any language to write block
names, signal names, and MATLAB Function comments

You can use Unicode characters for most textual content in Simulink, including names of
blocks and signals as well as comments in MATLAB scripts or functions.

Programmatic removal of mask dialog box controls and mask
parameters

You can use the following functions to remove dialog control elements and parameters
from the mask dialog box:
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Simulink Editor

* removeParameter: Removes a parameter from mask dialog box. For more
information, see Simulink.Mask.removeParameter.

+ removeDialogcontrol: Removes a dialog control element from mask dialog box. For
more information, see Simulink.Mask.removeDialogControl.

Alternative view of library contents in Library Browser

You can now view blocks in the Simulink Library Browser in alphabetical order or in
the order specified by the developer of the library. Right-click the blocks pane in the
Library Browser, and select Sort in library model order. The blocks appear in the
order specified by the developer of the library in the underlying library model. This
setting takes effect on all your libraries and stays in effect from session to session.

To return to alphabetical order, right-click and select Sort in alphabetical order. For
more information, see Reorder Blocks in Libraries.

Prompt to set key parameter when dragging a block from the Library
Browser

When you drag a block from the Library Browser into your model, you are prompted to
enter the key parameter. Setting the value this way lets you set the parameter without
opening the dialog box.

Printing to Postscript and EPS file formats

You now cannot print Simulink models or Stateflow charts to postscript and EPS file
formats.

Compatibility Considerations

If you want to print models or charts to a file, specify a .pdf extension for the output file.

Programmatic addition of areas and images in models

You can now add labeled areas and images to your Simulink model programmatically.
For more information, see add_block.
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Redesigned interface for Model Dependency Viewer

The Model Dependency Viewer tool has a new interface to view a model’s dependencies
on models and libraries. For more information, see Model Dependency Viewer.

Visual cue for undo and redo of block parameter value changes

After you undo or redo block parameter changes, a visual cue appears that shows the
current values of the affected parameters. For example:

1 In the vdp model, for an Integrator block, change the Initial condition parameter
value to 2 and select the Wrap state check box. Apply the changes.

2 Select Edit > Undo Parameter Changes. The cue shows that the parameters
returned to their original values.
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3 Select Edit > Redo Parameter Changes. The cue shows the restored parameters
values.
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For more information on Undo and Redo, see Interactive Model Building.
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New Interface for Scopes: View and debug signals with cursors and

measurements

The Simulink Scope and Floating Scope blocks with the Scope Viewer were significantly
upgraded. Simulink upgrades the scope blocks in a model that you previously created
and saved when you reopen it.

Major new features include simulation data analysis and debugging tools directly within
the Scope window, and tools similar to those of modern hardware bench-top oscilloscopes.
See Scope block reference for a list of features.

Note: The Signal Statistics, Bilevel Measurements, and Peak Finder panels require a
DSP System Toolbox™ or Simscape license.

Features from the previous scope were retained with some differences.

Capability

Previous Simulink Scope block

New Simulink Scope block

Number of input
ports

No limit

Maximum 96

Number of axes
(displays)

No limit

Maximum 16

Mapping axes
(displays) to input
ports

Number of axes equal to the
number of input ports.

Number of displays and number
of input ports are independent.

Ports are assigned to displays
sequentially, one port per
display. If there are more ports
than displays, the extra signals
are plotted in the last display.

Mapping axes
(displays) to signals

For the Floating Scope, select
a specific axis and assign
signals to axis using the Signal
Selector.

For the Floating Scope, the
number of displays and the
number of attached signals are
independent.
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Capability

Previous Simulink Scope block

New Simulink Scope block

Signals are assigned to displays
sequentially, one signal per
display. If there are more signals
than displays, the extra signals
are plotted in the last display.

Default logging
format

Structure with time

Dataset

Default line color

Color order yellow, magenta,
cyan, red, green, light gray.

Color order yellow, blue, orange,
green, purple, cyan, magenta.

Model Explorer
Search

Search by Property Name,
by Property Value, or by
Dialog Prompt.

Not possible to search property
names or values.

Block and dialog
parameters

The command
get_param(<scope block
path>, "ObjectParameters”)
returns a list of block
parameters and dialog
parameters.

The command
get_param(<scope block
path>, "ObjectParameters”)
returns a list of block
parameters. There are no dialog
parameters.

The command
get_param(<scope block
path>, "DialogParameters”)
returns empty.

Last buffer Data
Archiving

Last data buffer in external
mode data archiving saved to
the workspace by default

Data saved to workspace when
Write Intermediate Results to
WorkSpace is selected

Decimation and
Sample Time

Sample time and decimation
settings are not independent.

Sample time and decimation
settings are independent.
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Capability

Previous Simulink Scope block

New Simulink Scope block

Select signals for
Floating Scope

Several Signal Selectors opened
at once.

Selection from the model
diagram and from the Signal
Selector poorly coordinated.

Only one Signal Selector opened
at a time.

Selecting signals with the Signal
Selector disables selection from
the model diagram.

To select signals from the model
diagram, unlock the Floating
Scope, and then select signals.

Convert Scope block
to Floating Scope
block and back

Convert Scope to Floating
Scope using a Floating Scope
check box parameter.

Conversion not available.

Get a Scope or a Floating Scope
from the sinks library.

Floating property

Possible to convert a Scope
block to a Floating Scope
block using the command
set_param([model "/
Scope®], "Floating-”,
“on")

The Floating property is read-
only and set to "off". Not
possible to convert a Scope to a
Floating Scope.

Hybrid signal plot
style

Continuous elements of

a hybrid signal (mux of
continuous and discrete)
plotted using a line and discrete
elements plotted using stairs.

Signal elements of a hybrid
signal plotted using lines.
Behavior is consistent with a
Dataset logging timeseries plot
of hybrid signals.

Programmatic access
and scripting

Use set_param and
get_param.

Changing Scope dialog
parameters using set_param
can put the Scope in an
undefined state.

Use Scope Configuration object.

For backward compatibility,
set_param and get_param
continue to support dialog
parameters in the old Scope.
However, these parameters are
hidden.

Legend location

Location of a legend on a scope
serialized and restored when a
model is re-opened.

Placed legends anywhere within
a scope, but the location of the
legend is not serialized.




Simulation Analysis and Performance

Capability Previous Simulink Scope block New Simulink Scope block

Zoom Mode ZoomMode serialized and ZoomMode not serialized and
restored when a model is re- not restored when a model is re-
opened. opened.

Scope blocks in Scope data is not acquired Scope data is not acquired when

conditionally when subsystem is not enabled. |subsystem is not enabled.

executed subsystems
Lines drawn connecting gaps in |Gaps in plotted data visible.
plotted data.

Fast Restart APl: Programmatically run consecutive simulations more
quickly

You can now enable fast restart from the command line using set_param. See Get
Started with Fast Restart for more details.

You can also simulate a model in fast restart using sim and cvsim commands.

Previously, you could not use cvsim or signalbuilder with fast restart. In R2015b,
you can now use these commands.

Auto solver that chooses solver for a model

Starting with R2015b, you can use the auto solver to select a solver and step size for
simulating a model. The auto solver suggests a fixed-step or variable-step solver along
with maximum step size based on the dynamics of the model. Select the auto solver in
the solver pane and accept recommended settings in the solver information dialog box.
For more information, see Use Auto Solver to Select a Solver.

Tunability of struct parameters in rapid accelerator mode

You can now tune struct parameters when you simulate a model in rapid accelerator
mode. Previously you tuned struct parameters only in normal and accelerator modes.
You do not need to regenerate the rapid accelerator code when you tune struct
parameters.
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Port value labels for nonvirtual buses and bus signals

To monitor bus signal data during simulation, you can use port value labels for
nonvirtual buses. You can also display port labels for individual signals in a bus through
a new interface. For more information, see Display Value for a Specific Port.

Visualization of inserted rate transition blocks

When Simulink performs automatic rate transition, you can now see the rate transition
blocks that Simulink inserts in your model. You can also set the Initial Condition of
these blocks and change block parameters for rate transfers. For more information, see
Visualize Inserted Rate Transition Blocks.

Common format for saving states, output, and final states data and other
logging and loading techniques

The default for the Configuration Parameters > Data Import/Export > Format> >
parameter is now Dataset, which:

+ Simplifies postprocessing of logged data

+  Makes it easier to take advantage of features that require Dataset format

Extended support for root Inport loading using Dataset format in rapid
accelerator

Loading root Inport data using Dataset format in rapid accelerator mode is now
supported for underspecified and complex buses and arrays of buses.

Free MinGW-wé4 compiler for running simulations on 64-bit Windows®

You can now use the MinGW-w64 compiler from TDM-GCC to run simulations on 64-

bit Windows® hosts. You can run simulations in Accelerator and Rapid Accelerator
modes, build model reference simulation targets and S-functions, and simulate MATLAB
Function blocks. To download and install the compiler, see Install MinGW-w64 Compiler.
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Component-Based Modeling

More flexible configuration of Application lifespan (days) parameter in a
model reference hierarchy for simulation

The Configuration Parameters > Optimization > Application lifespan (days)
parameter can now be different for a parent and child model in a model reference
hierarchy during simulation. This flexibility can be useful during model reference
development. However, for code generation, the settings for this parameter must be
consistent throughout a model reference hierarchy.

Model Advisor checks for simplified initialization mode

The Model Advisor Check consistency of initialization parameters for Outport
and Merge blocks check has been replaced with four new checks. These checks help
to migrate your model to simplified initialization mode. For more information, see the
Model Advisor task Migrating to Simplified Initialization Mode Overview.

Changes to export-function models
Export-function models include these changes for R2015b.

Configuration Parameter for Scheduling Checks

A new model referencing configuration parameter, Enable strict scheduling checks
for referenced export-function models, lets you enable or skip checks on scheduling
order and sample-time consistency. This check applies to referenced export-function
models. For more information, see Enable strict scheduling checks for referenced export-
function models.

Triggered Sample Time for Function-Call Subsystems

You can now specify a discrete sample time for the function-call root-level Inport block for
function-call subsystems whose trigger block has Sample time type set to Triggered.
For more information, see Sample Time for Function-Call Subsystems in Export-
Function Models.

Execution Order of Function-Call Root-Level Inport Blocks

The algorithm to determine block execution order has changed. Root-level function-call
Inport block execution order is now determined first by priority, then by sample time,
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and then by the port number. For more information, see Execution Order for Function-
Call Root-level Inport Blocks.

Compatibility Considerations

The algorithm to determine block execution order has changed. Specify low priority on
the blocks you want to execute first.

Saving of list view parameters with Simul ink.ConfigSet.saveAs

Previously, Simul ink.ConfigSet.saveAs saved a configuration set that included the
enabled parameters that appear in the category view in the Configuration Parameters
dialog box. In R2015b, the method also saves the enabled parameters that appear only in
the list view.
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Project and File Management

Referenced Projects: Create reusable components for large modeling

projects

You can organize large projects into components through the use of referenced projects.
Componentization facilitates reuse, modular development, unit testing, and independent

release of components. In R2015b, you can:

* Add new components to your project by referencing other projects.

+ Use shortcuts to view and run files that belong to the referenced project.

+ Extract a folder from a project and convert the folder into a referenced project.

For more information, see:

+  Componentization of Large Projects

+ Airframe Project Reference Example

Configuration Parameters List View: List, edit, and search all

configuration parameters within your model

The Configuration Parameters list view provides a complete list of parameters in the
model configuration set. The list view includes parameters available in the category view
and parameters previously available only from the command line. To use the list view,

click the List button at the top of the Configuration Parameters dialog box.

£y Configuration Parameters: vdp/Configuration (Active)

=X

Category List
Select: Simulation time
Solver . .
Data Import/Export Start time: 0.0 Stop time: 20
Optimization X
Diagnostics Solver options
Hardware Implementation S S = P
Model Referencing Ype: riable-step olver:

> Simulation Target
» Code Generation

Max step size:  auto Relative tolerance:

Min step size:  auto Absolute tolerance:

You can use the list view to:

| ode45 (Dormand-Prince)

le-3

le-6

+ Search for specific parameters or filter parameters by category.
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*  Sort parameters.
+ Edit parameter values.
* View parameter dependencies.

*  Get parameter names for use in scripts.

%y Configuration Parameters: vdp/Configuration (Active) =nne x|

Configuration Parameter List

"/ IShow Al ~ || Parameter Value Command-Line Name [ +]
»  Solver Start time 0.0 StartTime
Simulation start time. Mote that the values that you specify as block...
»  Solver Stop time 20 StopTime
Simulation stop time.
*  Solver Type Variable-step - SolverType
Choose a variable or fixed-step solver.
* Solver Solver ode45 (Dormand-Prince) - Solver

Choose a solver. To enable this parameter

select Unconstrained or Specified for

“Periodic sample time constraint™

constrained -

For more information on the Configuration Parameters dialog box and the list view, see
Configuration Parameters Dialog Box Overview.

Project Creation from a Model: Quickly organize your model and dll
dependent files

Put your model and all dependent files into a Simulink project in three clicks. If your
model has supporting files, then a project makes it easier to manage. If you have more
than one model, version, or user, a project can help you. The project provides these
advantages:

+ Automate setup and shutdown tasks such as loading data and running scripts.

* Manage any required files (not just models and libraries, but all your supporting files,
such as data, images, scripts, functions, data dictionaries, requirements docs, etc.).

* Manage your path when you open and close the project.
* Visualize all file dependencies.

+  Use source control tools and compare versions.

In a Simulink model, select File > Simulink Project > Create Project from Model.
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Simulink runs dependency analysis on your model to identify required files and suggest a
project root location that contains all dependencies.

For details, see Create a Project from a Model.

Faster, Improved Dependency Analysis: Analyze projects several times
faster, identify referenced project files, and view library blocks

Dependency analysis of typical projects is faster, and includes new capabilities:

+ Identify dependencies on files in referenced projects.

* Trace library link dependencies to view library block names in the graph.

Analyzing all project files is now the default, which helps to ensure that you explore all
dependencies.

The dependency analysis workflow is simplified so that you can perform all operations
in the graph view using one toolstrip tab. The Simulink Project tree now has a single
Dependency Analysis view instead of three views separating file selection for analysis,
the table of results, and the Impact graph. The table view of files is still available as an
option, but you can perform all operations from the Impact graph view.

For details, see Perform Impact Analysis.

Management of shadowed and dirty files

Simulink Project now helps you to avoid working on the wrong files by detecting
shadowed files when you open a project. If loaded model files shadow your project model
files, you are prompted to inspect or close them. To avoid working on the wrong files,
close the files that shadow your project files before continuing to open your project. You
can choose to show or close individual files, or close all files that shadow with one click.
Previously, you only saw a warning in the command window when you opened a model
that another loaded file shadowed.

Simulink Project also now helps you to manage unsaved changes when closing a project.
When you close a project, it closes any project models that are open, unless they are dirty.
If model files have unsaved changes, then a prompt appears . You can see all dirty files,
grouped by project if you have referenced projects. To avoid losing work, you can save or
discard changes by file, by project, or globally.

For details, see Manage Shadowed and Dirty Model Files.
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Comparison of any pair of file revisions

In a Simulink project under source control, you can now select any pair of revisions to
compare. This ability is useful for investigating differences in older changelists. You can
now sort revisions by column headers in the Compare to Revision dialog box (e.g., by
date, revision number, or author). The Compare to Revision dialog box has an improved
layout, placing revision columns above the details pane, making it much easier to read.

Previously you could compare a revision only with your local file, making it more difficult
to investigate older changes. You could not compare between other revisions, and you
could not sort revisions.

For details, see Compare Revisions.

Updated power window example

The Power Window Control Project example has been updated to exercise more of the
logic in the power window controller. The example uses the From Spreadsheet block
to provide multiple sets of inputs to the controller. For more information, see Power

Window.

Case-sensitive model and library names

Function Element
Name

What Happens When
You Use This Function
Element

Use This Instead

Compatibility
Considerations

Case-insensitive
model or library
name

Simulink uses

the closest case-
insensitive match,
and warns

Specify exact case

Case-insensitive
matching will be
removed in a future
release.

Warning for Model Info Configuration Manager

Functionality

What Happens
When You Use This
Functionality

Use This Instead

Compatibility
Considerations

Model Info block
Configuration
Manager

When a model's
configuration
manager is active,

For a more flexible
interface to source
control tools, use

The Configuration
Manager will be
removed in a future
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Functionality What Happens Use This Instead Compatibility
When You Use This Considerations
Functionality
you see a new Simulink Project release. For help,
warning when instead of the Model [see the Upgrade
loading or saving the |Info block. Advisor checks:
model, or when you Identify Model Info
access the Model Info blocks that use
block. the Configuration

Manager and
Identify Model
Info blocks that
can interact with
external source
control tools.
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Interval Logging: Specify start and stop time intervals to log only the data
you need

You can use the new Configuration Parameters > Data Import/Export > Logging
intervals parameter to specify an interval for logging data for:

*+ Time
+ States
* Output

+ Signal logging
* The To Workspace block
* The To File block

Limiting logging to specified intervals:

+ Allow you to view specific logged data without changing the model or adding
complexity to a model

+ Simplifies analysis of logged data

*  Reduces simulation time

*  Reduces memory consumption

Always-On Tunability: Tune all block parameters and workspace
variables during a simulation

Prior to R2015b, you selected Configuration Parameters > Optimization > Signals
and Parameters > Inline parameters to increase simulation speed by treating

block parameter values as constants. In this case, you could not tune these parameters
during simulation. To preserve tunability for individual block parameters, you used data
objects or the Model Parameter Configuration dialog box. Alternatively, clearing Inline
parameters enabled block parameter tunability by default while reducing simulation
speed.

In R2015b, you can tune block parameters during simulation, and you retain the
simulation speed benefit. You do not need to use data objects or the Model Parameter
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Configuration dialog box to preserve parameter tunability during simulation. Inline
parameters is now called Default parameter behavior. This configuration parameter

does not affect simulation.

Prior to R2015b, when you displayed sample time colors, magenta indicated constant
sample time. Now, magenta indicates blocks whose output values are constant. The
term constant refers to blocks whose output values change only when you tune block

parameters.

The table describes some block and system level changes caused by these enhancements.

Description of change

Behavior in R2015a

Behavior in R2015b

Constant block with sample
time set to InF

Inline parameters
selected: The block receives
constant sample time. When
you display sample time
colors, the block appears
magenta in color.

Inline parameters
cleared: The block inherits
a sample time from its
context. The block color
indicates the inherited
sample time.

The block computes its
output at the start of
simulation and whenever
you tune a block parameter.
When you display sample
time colors, the block
appears magenta in color.

Relationship between
sample time and parameter
tunability

If you use a tunable
parameter, such as a
Simulink.Parameter
object with a storage class
other than Auto, to specify
a numeric block parameter,
the block inherits a sample
time from its context.

The block computes its
output at the start of
simulation and whenever
you tune a block parameter.
When you display sample
time colors, the block
appears magenta in color.

Weighted sample time math
block

Inline parameters
selected: If any of the

block inputs are constant,
Simulink displays an error.

Inline parameters
cleared: The block inherits

The block inherits a sample
time from its context.
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Description of change

Behavior in R2015a

Behavior in R2015b

a sample time from its
context.

For more information about changes to the configuration parameter Inline parameters
with respect to code generation, see the R2015b Simulink Coder release notes.

For more information about constant sample time, see Constant Sample Time.

Compaitibility Considerations

* An error occurs in conditionally executed subsystems where:

A divide-by-zero operation occurs and all the blocks in the computation have

constant output values.

* The control input of an Index Vector block specifies an index that is out of range,
and the block input has a constant value.

Workaround: Use Upgrade Advisor to run Check model for parameter
initialization and tuning issues. For more information, see Check model for
parameter initialization and tuning issues.

*  Prior to R2015b, if a model contained Level-2 MATLAB S-Function blocks, and you
selected Inline parameters, these blocks allowed constant sample time by default.
In R2015b, Level-2 MATLAB S-Function blocks inherit a sample time from their

context by default.

Workaround: To enable these blocks to allow constant sample time, explicitly set
SetAl lowConstantSampleTime to true.

+ If you set Default parameter behavior to Inlined, and you log blocks that have
tunable parameters, a mismatch can occur in the number of data points logged
between the simulation and code generation workflows. However, the value logged
remains constant where extra points are logged.

* In the code generation workflow, when the Merge block receives a constant value and
non-constant sample times, one of these conditions must hold. Otherwise Simulink

displays an error.

* The source of the constant value is a grounded signal.

The source of the constant value is a constant block with a non-tunable parameter.
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* There is only one constant block that feeds the Merge block.

+ All other input signals to the Merge block are from conditionally executed
subsystems.

* The Merge block and outport blocks of all conditionally executed subsystems
should not specify any initial outputs.
For more information, see Merge.

If you generate subsystem code for a subsystem that has any constant inputs, an error
can occur.

Workaround: Change the sample time at the source to an inherited or periodic sample
time.

Models that had Inline parameters cleared and simulated without error in releases
prior to R2015b can have rate transition issues in R2015b. These issues occur because
all constant blocks now receive constant sample time regardless of the setting for
Default parameter behavior. This change can produce different sample time
propagation results.

Workaround: Use Upgrade Advisor to run Check model for parameter
initialization and tuning issues. For more information, see Check model for
parameter initialization and tuning issues.

Suppose you generate code for a model where these conditions are true:

The default parameter behavior is tunable.

A constant block executes with a downstream rate that is not the fastest rate.

The logged data appears to be delayed. There is a delay equal to one step of the slower
rate that the block executes at. Simulink displays a warning during code generation.

This issue does not affect signal logging during simulation.

If you write TLC code to generate code from an inlined S-function, and if the TLC code
contains an Outputs function, you must modify the TLC code if all of these conditions
are true:

* An output port uses or inherits constant sample time. The output port has a
constant value.

The S-function is a multirate S-function or uses port-based sample times.
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In this case, the TLC code must generate code for the constant-valued output port
by using the function OutputsForTID instead of the function Outputs. For more
information, see Specifying Constant Sample Time (Inf) for a Port.

Previously, if you selected Inline parameters, parameters that used the storage
class Auto (including numeric MATLAB variables) were not tunable during
simulation. The code generated for models referenced in accelerator mode and the
code generated for top models or freestanding models in rapid accelerator mode
inlined the numeric values of the variables. In R2015b, these parameters are tunable,
and the code preserves them.

* These parameters must exist throughout simulation. For example, if you reference
a model in accelerator mode, you cannot use the referenced model CloseFcn
callback to clear the parameters. Consider using the callback of the parent model
instead. Alternatively, store the parameters in a Simulink data dictionary.

*  Suppose that you use a variable myVar in an inconsistent way, for example:

* You use myVar as the value of the Gain parameter of a Gain block in a
referenced model submodell. The Gain block applies a data type, such as
int32, to myVar.

* You also use myVar in a Gain block in the referenced model submodel2. This
Gain block applies a different data type, such as intl6, to myVar.

In R2015b, you cannot use myVar in an inconsistent way across these referenced
models because myVar is tunable. To simulate the models, resolve the inconsistent
usage. For example, modify the referenced models submodell and submodel?2 so
they apply the same data type to myVar.

Previously, the code generated in rapid accelerator mode did not preserve expressions,
such as myVar + myOtherVar * 5, that you used to specify block parameter values.
In R2015b, the code preserves these expressions.

+ If a block parameter value references workspace variables, you cannot change
the block parameter value during rapid accelerator simulation. Instead, you can
tune the values of the referenced variables. If you use a script to change the block
parameter value during simulation, modify the script so it changes the values of
the variables instead.

Suppose that a For Each subsystem has a mask parameter a whose value is
the three-element array [1 2 3]. Suppose that the subsystem partitions the
parameter a three times so that each iteration of the subsystem uses one of the
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elements in the array. You cannot use the expression 15.23"a to specify a block
parameter value inside the subsystem because the expression contains an operator
that the code generator does not support.

To simulate the model, consider implementing the expression as a block algorithm
instead. For more information about the operators that the code generator
supports in tunable expressions, see Tunable Expression Limitations.

*  Previously, you could select Inline parameters to prevent mask initialization code
from executing during simulation. This technique prevented code that made changes
to the model from executing. If the changes generated errors during simulation, for
example by attempting to add blocks to the model, selecting Inline parameters
prevented the errors.

In R2015b, all mask initialization code executes during simulation. To avoid errors
during simulation, consider wrapping the mask initialization code in additional code
that prevents it from executing during simulation.

Arrays of structures as parameters
You can use arrays of structures as parameters to:

+ Initialize arrays of bus signals that pass through blocks like Unit Delay. Arrays of
buses help you to reduce signal line density in model diagrams. For more information,
see Specify Initial Conditions for Bus Signals.

+  Specify the Constant value parameter in a Constant block. You can use this
technique to compactly represent multiple constant-valued signals as an array of
buses. For an example, see the Constant block.

*  Group workspace variables into a single variable whose value is an array of
structures. You can use this technique to organize related variables and reduce
workspace clutter. For more information about structure parameters, see Organize
Related Parameters in Structures and Arrays of Structures.

* Parameterize a For Each Subsystem, which can help you repeat an algorithm over
multiple inputs. The subsystem can partition mask parameters that are arrays of
structures. For an example, see Repeat an Algorithm Using a For Each Subsystem.
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Improved methods to create custom data obijects
Model Explorer

Previously, to create data objects such as Simul ink.Parameter and
simulink.Signal, you used the Model Explorer buttons Add Parameter L) and Add

Signal L=, To create data objects from a package other than Simulink, you specified the
package using Simulink Preferences.

In R2015b, to select a data class other than those in the package Simulink, you can use
the new arrows beside these buttons. You can select any data class whose definition is on
the MATLAB path, including custom classes such as myPackage . myParameter.

For more information about creating data objects, see Data Objects.

Data Object Wizard

Previously, to create custom data objects using the Data Object Wizard, you specified a
default data class package using Simulink Preferences.

In R2015b, to create objects from data classes in any package, including your own
packages, you can select the classes using the Data Object Wizard.

For more information about creating data objects using the Data Object Wizard, see
Create Data Objects for a Model Using Data Object Wizard.

No creation of parameter objects for mask initialization code

You now cannot use mask initialization code to create parameter objects. Parameter
objects are objects of the class Simul ink.Parameter and of any of its subclasses that
you create. For more information about block masking and using MATLAB code to
initialize a mask, see Initialize Mask.

Compatibility Considerations

If you use existing mask initialization code that creates parameter objects, you must edit
the code so that it does not create parameter objects.
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Sample time for signal logging

In the Signal Properties dialog box, you can use the new Sample Time option for a
signal marked for signal logging. This option:

+  Maintains the separation of design and testing, because you do not need to insert a
Rate Transition block to have a consistent sample time for logged signals

*  Reduces the amount of logged data for continuous time signals, for which setting
decimation is not relevant

+ Eliminates the need to postprocess logged signal data for signals with different
sample times

For details, see Set Sample Time for a Logged Signal.

Same format for logging states, output, and final states as used for other
logging and loading techniques

The default for the Configuration Parameters > Data Import/Export > Format
parameter is now Dataset, which:

+ Simplifies post processing of logged data
+  Makes it easier to take advantage of features that require Dataset format

Root Inport loading in rapid accelerator mode using Dataset format
In rapid accelerator mode, using Dataset format to load root Inport blocks now supports:

+ Specifying a single Dataset object, as an alternative to specifying a long comma-
separated list using the Configuration Parameters > Data Import/Export >
Input parameter

+ Loading of buses and arrays of buses, including underspecified buses and arrays of
buses

* Loading of fixed-point and enum data
*  No code regeneration for new data

Logged signals with propagated names

Signal logging and root Outport block logging data for a signal captures the propagated
signal name if the logging format is Dataset and:
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* For signal logging, you:

+  Mark one or more signals for signal logging and in the Signal Properties dialog box
select Show Propagated Signals.

Enable Configuration Parameters > Data Import/Export > Signal logging.

*  For root Outport block logging, you select Configuration Parameters > Data
Import/Export > Output.

The Simulink.SimulationData.Signal class has a new PropagatedName property
for displaying the propagated signal name. The Simulink.SimulationData.Dataset
class displays propagated signal names as a comment (the propagated signal name
preceded by a percent sign (%)). In the logged data, the propagated signal name does not
include angle brackets (<>).

Tolerance for data type mismatch between bus elements and structure

fields

Previously, when you used a MATLAB structure to initialize a bus signal, or to drive a
bus signal using a Constant block, you matched the data types of the structure fields
with those of the bus signal elements.

In R2015b, you do not need to match the data types when you simulate a model. You
can use doubles to specify the structure field values, and use the bus signal elements
to control the data types. Prior to simulation, the bus elements cast the structure field
values.

However, for other applications such as creating tunable initial conditions in the
generated code, you must match the data types.

To decide whether to explicitly specify field data types, see Decide Whether to Specify
Data Types for Structure Fields.
Summary of changes made to data dictionary

If you use a Simulink data dictionary to store the variables that a model uses, you can
display a summary of all of the unsaved changes that you made to the dictionary. You
can use this technique to:

*  Track your changes while you create and modify dictionary entries.

* Decide which changes to keep or discard before you close an unsaved dictionary.
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* Recover variables that you deleted.

*  Recover dictionary references that you removed.

For an example, see View and Revert Changes to Entire Dictionary.

Rename All in Goto blocks

You can use the Rename All button in Goto block dialog boxes to quickly rename the
corresponding tag in From and Goto Tag Visibility blocks. For more information, see the
Goto block.

Change to visibility of Sampl ingMode property of signal objects

The Simulink.Signal property Sampl ingMode is hidden if you set it to "auto®, the
default value. Previously, when you used a Simul ink.Signal object to define a data
store, you set Sampl ingMode to "Sample based®. You can now leave the property at
the default value, "auto”.

If you use existing code that creates Simul ink.Signal objects and changes the value of
the Sampl ingMode property, the property is not hidden for these objects.

This change supports recent changes to frame-based processing with DSP System
Toolbox. For more information, see Sample- and Frame-Based Concepts in the DSP
System Toolbox documentation.

Continued availability of Simulink.saveVvars

The R2014a Release Notes state that the function Simul ink.saveVars will be removed
in a future release. As of R2015b, you can continue to use this function. Existing scripts
that use Simulink.saveVars do not generate warnings.

However, Simul ink.saveVars is not recommended. To save workspace variables to a
MATLAB script, use matlab.io.saveVariablesToScript instead of Simul ink.saveVars.

Simulink.SimulationData.Dataset updates
Simulink.SimulationData.Dataset.find is a new method that finds elements with

specified property names and values. For documentation on this method, in the MATLAB
Command Window, type help Simulink.SimulationData.Dataset.find.
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Edit Input button is now Connect Input

The Input > Edit Input button on the Configuration Parameters Data Import/Export
pane is now Connect Input.

Legacy Code Tool support for conditional outputs

When you use the legacy_code function, you can now specify whether the legacy code
conditionally writes the output ports. Use the outputsConditional lyWritten
S-function option. If true, the generated S-function specifies that the

memory associated with each output port cannot be overwritten and is global
(SS_NOT_REUSABLE_AND_GLOBAL). If false, the memory associated with each output
port is reusable and is local (SS_REUSABLE_AND_LOCAL). By default, the value is false

©).
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Connection to Hardware

Raspberry Pi 2 Support: Run Simulink models on Raspberry Pi 2 Model B
hardware

You can use the Simulink Support Package for Raspberry Pi Hardware with Raspberry
Pi 2 Model B hardware.

Arduino Yun: Design and run Simulink models on Arduino Yun hardware

You can use the Simulink Support Package for Arduino Hardware with Arduino Yun
hardware.

Hardware Implementation Selection: Quickly generate code for popular
embedded processors

Specification of hardware configurations has been simplified. Top-level Configuration
Parameters dialog box panes, Run on Target Hardware and Coder Target, have been
removed. Parameters previously available on those panes now appear on the Hardware
Implementation pane. A parameter has also moved from the Code Generation pane
to the Hardware Implementation pane.

This list summarizes the R2015b changes and new behavior:

* By default, the Hardware Implementation pane lists Hardware board, Device
vendor, and Device type parameter fields only.

+ If you use Simulink without a Simulink Coder license, initially parameters on the
Hardware Implementation pane are disabled. To enable them, click Enable
hardware specification. The parameters remain enabled for the current MATLAB
session.

* By default, the Hardware board list includes: None or Determine by Code
Generation system target file, and Get Hardware Support Packages.
After installing a hardware support package, the list also includes corresponding
hardware board names.

+ If you select a hardware board name, parameters for that board appear in the dialog
box display.
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Lists for the Device vendor and Device type parameters have been updated to
reflect hardware that is available on the market. The default Device vendor and
Device type are Intel and x86-64 (Windows64), respectively.

If Simulink Coder is installed, the revised Hardware Implementation pane
identifies the system target file that you selected on the Code Generation pane.

A Device details option provides a way to display parameters for setting details such
as number of bits and byte ordering.

To specify target hardware for a Simulink support package, select a value from
Configuration Parameters > Hardware Implementation > Hardware board.
Before R2015b, you selected Tools > Run on Target Hardware > Prepare to run.
Then, you selected a value from Configuration Parameters > Run on Target
Hardware > Target hardware.

To specify target hardware for an Embedded Coder support package, select a value
from Configuration Parameters > Hardware Implementation > Hardware
board. Before R2015b, you selected a value from Configuration Parameters >
Code Generation > Target hardware.

The Test hardware section was removed. Configure test hardware from the
Configuration Parameters list view. Set ProdEqTarget to off, which enables
parameters for configuring test hardware details.

If you set Configuration Parameters > Code Generation > System target file
toert.tlc, realtime.tlc, or autosar.tlc, the default setting for Configuration
Parameters > Hardware Implementation > Hardware board is None. If you set
System target file to value other than ert.tlc, autosar.tlc, or realtime.tlc,
the default setting for Hardware board is Determine by Code Generation
system target file.

For more information, see Hardware Implementation Pane.

Compatibility Considerations

Starting in R2015b:

By default, the Hardware Implementation pane lists Hardware board, Device
vendor, and Device type parameter fields only. To view parameters for setting
details, such as number of bits and byte ordering, click Device details.

The following devices appear on the Hardware Implementation pane only for
models that you create with a version of the software earlier than R2015b. These
devices are considered legacy devices.
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Generic, 32-bit Embedded Processor
Generic, 64-bit Embedded Processor (LLP64)
Generic, 64-bit Embedded Processor (LLP64)
Generic, 16-bit Embedded Processor
Generic, 8-bit Embedded Processor

Generic, 32-bit Real-Time Simulator
Generic, 32-bit x86 compatible

Intel, 8051 Compatible

Intel, x86-64

SGI, UltraSPARC Iii

In R2015b, if you open a model configured for a legacy device and change the Device
type setting, you cannot select the legacy device again.

Device parameter Signed integer division rounds to is set to Zero instead of
Undefined. For some cases, numerical differences can occur in results produced with
Zero versus Undefined for simulation and code generation.

This change does not apply to legacy devices.

To associate a new model with an existing configuration set that has the following
characteristics, configure the model to use the same hardware device as the existing
model.

*  The model consists of a model reference hierarchy. Models in the hierarchy use
different configuration sets.

The existing configuration set was saved as a script and associated with a
configuration set variable.

If the code generator detects differences in device parameter settings, a consistency
error occurs. To correct the condition, look for differences in the device parameter
settings, and make the appropriate adjustments.
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Virtual bus signal inputs to blocks that require nonbus or nonvirtual bus
input

Starting in R2015b, virtual bus signal input to blocks that require nonbus or nonvirtual
bus input can cause an error. The error occurs when a virtual bus input signal is
generated by a block that specifies a bus object as its output data type. Examples of
blocks that can specify a bus object as its output data type include a Bus Creator block or
a root Inport block. The blocks that cause an error when they have a virtual bus input in
this situation are:

+ Assignment

* Delay

This block causes an error only if you set an initial condition from the dialog that is a
MATLAB structure or zero and you specify a value for State name.

*  Permute Dimension
* Reshape
+  Selector

* Unit Delay

This block causes an error only if you set an initial condition from the dialog that is a
MATLAB structure or zero and you specify a value for State name.

* Vector Concatenate

Generating an error when this situation occurs helps to promote consistent output by
requiring proper input to these blocks.

To check for proper virtual bus usage and for Mux blocks used to create bus signals, use
the new Upgrade Advisor Check bus usage check.

The new Upgrade Advisor check inserts a Bus to Vector block to attempt to convert
virtual bus input signals to vector signals. For issues that the Upgrade Advisor identifies
but cannot fix, modify the model manually. For details, see Correct Buses Used as Muxes
and Prevent Bus and Mux Mixtures.
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Compatibility Considerations

In R2015b, a virtual bus input signal to the affected blocks causes an error message,
regardless of the Configuration Parameters > Diagnostics > Connectivity > Bus
signal treated as vector setting.

In models created in releases earlier than R2015b, if the Bus signal treated as vector
diagnostic setting is error, there is no compatibility issue when you run the model in
R2015b.

To help you to address this issue, use the Upgrade Advisor Check bus usage check.

Entire nested bus assignment for Bus Assignment block

If a bus signal input to a Bus Assignment block contains a nested bus signal, then you
can assign or select the nested bus signal as a whole. However, the nested bus cannot be
nested inside of an array of buses. Before R2015b, you had to assign each signal in the
nested bus.

Support for entire nested bus signal assignment reduces:

*  The number of blocks in a diagram

* The maintenance effort

For details, see Bus Assignment.
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Waveform Generator Block: Define and output arbitrary waveform
signals

The Waveform Generator block outputs waveforms using signal notations. This block is
located in the Sources sublibrary.

From Spreadsheet Block: Read signal data into Simulink from a
spreadsheet

The From Spreadsheet block reads data from spreadsheets. This block is located in the
Simulink Extras/Additional Sources sublibrary.

MATLAB System block support for nonvirtual buses

The MATLAB System block now supports nonvirutal buses. For more information, see
Nonvirtual Buses and MATLAB System Block. For an example, see Using Buses with
MATLAB System Blocks.

Inport block update

The Inport block now has a Connect Input button. Use this button to import, visualize,
and map signal and bus data to root-level inports using the Root Inport Mapping tool.

From File updates for file name and signal preview
The From File block File name parameter has been updated to include:

+ A file browse button

* A view button that lets you plot and inspect signals.
Inheriting of continuous sample time for discrete blocks
The Configuration Parameters > Diagnostics > Sample Time > Discrete used as

continuous diagnostic was removed. If a discrete block (such as the Unit Delay block)
inherits a continuous sample time, the block returns an error.
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Block Enhancements

Evenly spaced breakpoints in Lookup Tables

A new format is available to specify evenly spaced breakpoints in the Prelookup and n-

D Lookup Table blocks. For more information, see the Specification parameter in the
Prelookup block reference page and the Breakpoints specification parameter in the n-
D Lookup Table reference page.

Integrator block: Wrapped states for modeling rotary and cyclic state
trajectories

The Integrator block has been enhanced to support wrapped states when modeling
rotary, cyclic, or periodic state trajectories. This support for wrapping states provides
these advantages.

+ It eliminates simulation instability when your model approaches large angles and
large state values.

* It reduces the number of solver resets during simulation and eliminates the need for
zero-crossing detection, improving simulation time.

+ It eliminates large angle values, speeding up computation of trigonometric functions
on angular states.

+ It improves solver accuracy and performance and enables unlimited simulation time.

Variant Subsystem block: Enhanced option for generating preprocessor
conditionals

The option Generate preprocessor conditionals in the Variant Subsystem block
parameters dialog box has been replaced with the option Analyze all choices during
update diagram and generate preprocessor conditionals. When you select this
option, Simulink analyzes all variant choices during an update diagram or simulation.
This analysis provides early validation of the code generation readiness of all variant
choices.

Compaitibility Considerations
Previously, when the option to generate preprocessor conditionals was switched on,

Simulink analyzed all variant choices only during the code generation phase. Now,
Simulink performs this analysis during the update diagram phase. As a result, errors
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that you would normally see during code generation appear earlier, during an update
diagram.

Constant sample time in S-function blocks

MATLAB S-function blocks no longer support a constant sample time (Inf) for their
ports by default.

Compatibility Considerations

To allow ports in your MATLAB S-function blocks to have a sample time of Inf, use the
SetAllowConstantSampleTime command.
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MATLAB Function Blocks

Calling of Simulink Functions

You can call a Simulink Function block from inside of a MATLAB Function block. You
can also call Stateflow functions with Export Chart Level Functions (Make Global)
and Allow exported functions to be called by Simulink checked in the chart
Properties dialog box.

Nondirect feedthrough in MATLAB Function blocks

By default, MATLAB Function blocks have direct feedthrough enabled. To disable, in

the Ports and Data Manager, you can now clear the Allow direct feedthrough check
box. Nondirect feedthrough enables semantics to ensure that outputs rely only on current
state.

To use nondirect feedthrough, do not program outputs to rely on inputs or updated
persistent variables. For example, do not use the following code in a nondirect

feedthrough block:
counter = counter + 1; % update state
output = counter; % compute output based on updated state

Instead, use code such as:

output = counter; % compute output based on current state
counter = counter + 1; % update state

Also, nondirect feedthrough semantics require function inlining. Do not disable inlining.

Using nondirect feedthrough enables you to use MATLAB Function blocks in a feedback
loop and prevent algebraic loops.

Overflow and data range detection settings unified with Simulink

Previously, you controlled overflow detection in MATLAB Function blocks with the
configuration parameter Detect wrap on overflow. This parameter was on the
Simulation Target pane in the Model Configuration Parameters dialog box.

You now control the overflow detection for MATLAB Function blocks with the
configuration parameter Wrap on overflow. This parameter is on the Diagnostics:
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Data Validity pane in the Model Configuration Parameters dialog box. Choose one of
these settings: none, warning, and error.

Previously, you controlled data range error checking in MATLAB Function blocks in the
editor, with Simulation > Debug > MATLAB & Stateflow Error Checking Options
> Data Range.

You now control data range checking with the configuration parameter Simulation
range checking. This parameter is on the Diagnostics: Data Validity pane in the
Model Configuration Parameters dialog box. Choose one of these three settings: none,
warning, and error.

See Diagnostics Pane: Data Validity.

Compaitibility Considerations

When you open a model with a MATLAB Function block saved in a previous release, a
change in behavior is possible. These options are no longer valid.

+ Detect wrap on overflow on the Simulation Target pane of the Model
Configuration Parameters dialog box

* Simulation > Debug > MATLAB & Stateflow Error Checking Options > Data
Range in the Stateflow editor

In R2015b, the software determines overflow detection and data range by the setting
of these Simulink options on the Diagnostics: Data Validity pane in the Model
Configuration Parameters dialog box.

* Wrap on overflow

* Simulation range checking

Set each configuration parameter to none, warning, or error. The software displays a
warning if the previous MATLAB Function block options saved with the model were set
differently than the current Simulink options.

The command-line parameter SFSimOverflowDetection is no

longer valid. Use IntegerOverflowMsg instead. The API parameter
Debug.RunTimeCheck.DataRangeChecks is no longer valid. Use the command-line
parameter SignalRangeChecking instead.
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When you save a current model with a MATLAB Function block in a previous version,
the current Simulink parameters are saved. Both the MATLAB Function block overflow
and data range parameters are saved as selected.

No frame-based sampling mode for outputs

In R2015b, you can no longer set the sampling mode of outputs to frame based in
MATLAB Function blocks. Models created in previous releases using frame-based
sampling mode continue to behave as they did before this release.

Code generation for cell arrays
In R2015b, you can generate code from MATLAB code that uses cell arrays.

The code generation software classifies a cell array as homogeneous or heterogeneous.
This classification determines how a cell array is represented in the generated C/C++
code. It also determines how you can use the cell array in MATLAB code from which you
generate C/C++ code. See Homogeneous vs. Heterogeneous Cell Arrays.

As long as you do not specify conflicting requirements, you can control whether a
cell array is homogeneous or heterogeneous. See Control Whether a Cell Array is
Homogeneous or Heterogeneous.

For information about restrictions when you use cell arrays in a MATLAB Function
block, see Cell Array Requirements and Limitations for Code Generation.

LAPACK calls during simulation for algorithms that call linear algebra
functions

To improve the simulation speed for MATLAB Function block algorithms that call linear
algebra functions, the simulation software can now call LAPACK functions. If the input
arrays for the linear algebra functions meet certain criteria, the simulation software
generates calls to relevant LAPACK functions.

LAPACK is a software library for numerical linear algebra. MATLAB uses this library
in some linear algebra functions such as eig and svd. The simulation software uses the
LAPACK library that is included with MATLAB.

For information about the open source reference version of LAPACK, see LAPACK —
Linear Algebra PACKage.
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Code generation for additional Image Processing Toolbox and Computer
Vision System Toolbox functions

Image Processing Toolbox

bwareaopen houghpeaks immse integralBoxFilter
grayconnected imabsdiff imresize psnr

hough imcrop imrotate

houghlines imgaborfilt imtranslate

See Image Processing Toolbox in Functions and Objects Supported for C and C++ Code
Generation — Category List.

Computer Vision System Toolbox

* insertText
+ extractLBPFeatures
See Computer Vision System Toolbox in Functions and Objects Supported for C and C++

Code Generation — Category List.

Code generation for additional Statistics and Machine Learning Toolbox
functions

*+ kmeans

* randsample

See Statistics and Machine Learning Toolbox in Functions and Objects Supported for C
and C++ Code Generation — Category List.

Code generation for additional MATLAB functions
Data Types in MATLAB

+ cell
+ fieldnames

*  struct2cell
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See Data Types in MATLAB in Functions and Objects Supported for C and C++ Code
Generation — Category List.

String Functions in MATLAB

iscellstr

strjoin

See String Functions in MATLAB in Functions and Objects Supported for C and C++
Code Generation — Category List.

Code generation for additional Communications System Toolbox, DSP
System Toolbox, and Phased Array System Toolbox functions and System
objects

Communications System Toolbox
comm.CoarseFrequencyCompensator

See Communications System Toolbox in Functions and Objects Supported for C and C++
Code Generation — Category List.

DSP System Toolbox

dsp.IIRHalfbandDecimator
dsp.ITRHalfbandInterpolator
dsp.AllpassFilter

See DSP System Toolbox in Functions and Objects Supported for C and C++ Code
Generation — Category List.

Phased Array System Toolbox

phased. TwoRayChannel
phased.GCCEstimator
phased.WidebandRadiator
phased.SubbandMVDRBeamformer
phased.WidebandFreeSpace
geephat
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See Phased Array System Toolbox in Functions and Objects Supported for C and C++
Code Generation — Category List.
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Simulink Editor

Bus Smart Editing Cue: Automatically create a bus from a set of signals

You can select multiple blocks or signals in an area of a model to create a bus for.

= 4L f % fER O

Using the Create Bus button to create a bus automatically performs these actions:

* Creates a Bus Creator block with the right number of inputs

Resizes the Bus Creator block to an appropriate size for the number of input signals
*  Orients the Bus Creator block to the direction of the input signals
*  Connects the signals to the Bus Creator block

Area Annotations: Call out and separate regions of interest in model

You can select multiple objects in an area of a model to annotate an area of interest in
your model.
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Simulink Editor

1  Inthe Simulink Editor, drag to select the area of the model you want to create an
area around.

2 In the action bar, click Create Area.
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For more information, see Box and Label Areas of a Model.

Perspectives Controls: Access alternative views of your model, such as
harness and interface views

You can switch to different views of a model, such as harness view to view test harnesses
and interface view to view interfaces of your system.

1 In the Simulink Editor, click the control in the lower-right corner.

108% [afu]=I%]

2 Click the view you want to see.
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Saving of viewmarks in Simulink models

You can now store viewmarks with your model. For more information, see Use
Viewmarks to Save Views of Models.

Highlighting of the subsystem you navigated from

When you navigate out of a subsystem, Simulink now highlights that subsystem
temporarily. The highlight helps you to identify the subsystem you were working in most
recently.

10
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Annotation connector colors and width

You can now specify the color and width of annotation connectors. Right-click the
annotation connector and use the Format menu.
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To create an annotation connector, see Add Lines to Connect Annotations to Blocks

Undo and redo of block parameter value changes

Block parameter changes using block dialog boxes are now undoable. When you use
Undo after you make changes to block parameter values, the values revert and the
affected block briefly appears highlighted. A Redo command as the next action restores
the changes and also briefly highlights the block. For more information on Undo and
Redo, see “Interactive Model Building”.

Display of product name in model title bar

The Simulink Editor now displays the word Simulink next to the model name in the
model title bar.
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Simulation Analysis and Performance

Dashboard Block Library: Tune and test simulations with graphical
controls and displays

The Dashboard block library contains controls and displays that enable you to tune block
parameters or monitor signals. The controls can be active during simulation so you can
tune parameters and optimize your model while it is running or paused. The blocks are
added directly to your Simulink model canvas and connected to signals or blocks. The
Dashboard block library includes:

* Knobs

+  Switches

+  Gauges

* Dashboard scope

+ Lamp

Algebraic Loop Highlighting: Find and remove algebraic loops in the
model to boost simulation speed

You can now identify and remove all algebraic loops in your model using the new
highlight feature. This option traverses through the hierarchy of a model to highlight
real and artificial algebraic loops. A report lists the loops with color codes for easy
isolation. This technique allows you to view all the loops in a model simultaneously, so
you can remove them quickly and speed up your simulation.

For more information, see Highlight Algebraic Loops in the Model.

Faster Simulations with Accelerated Referenced Models: Run faster
consecutive simulations and step back and forth through simulations

Simulating referenced models in Accelerator mode now supports these actions that
involve using SimState:

* Do a fast restart
* Save complete SimState in final state logging

* Restart from saved state
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* Step through a simulation

If the referenced model simulated in Accelerator mode contains any of these blocks, then
you cannot perform the actions listed above:

* Level 2 MATLAB S-Function

+ MATLAB System

* n-D Lookup Table

*  S-Function (with custom SimState or PWork vectors)

* To File

*  Simscape blocks

Use SimulationMetadata to retrieve simulation metadata information

You can store and retrieve metadata about a simulation using SimulationMetadata.
The SimulationOutput object of the simulation contains the metadata object. Use
SimulationMetadata to analyze archived simulations or compare results from multiple
simulations. See Simulink.SimulationMetadata for more details.

Simplified conversion of logged data to Dataset format for a common
logged data format

You can use the Simulink.SimulationData.Dataset constructor to convert data that
was logged in one of the following formats to Dataset format:

+ Array

*  Structure

*  Structure with time

+ MATLAB timeseries

* ModelDatalLogs

Converting data from other Simulink logging formats to Dataset format simplifies
writing scripts to post-process data logged using different:

+ Logging techniques (for example, for models with multiple To Workspace blocks using
different data formats or for models that use To Workspace blocks and log signals
using Mode IDatal ogs format)
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*  Simulation modes (for example, Normal and Accelerator)

The conversion to Dataset format also makes it easier to take advantage of features
that require Dataset format. Now you can easily convert data logged in earlier releases
that used a format other than Dataset to work well with Dataset data in a more recent
release.

You can use the Simulink.SimulationData.Dataset.concat method to combine
Dataset objects into one concatenated Dataset object.

For more information, see Simulink.SimulationData.Dataset.

Default setting for Automatic solver parameter selection

The default setting for Automatic solver parameter selection in the Diagnostics
pane of the Model Configuration Parameters dialog box is now set to none. Previously,
the default setting for this option was warning.

Improved heuristic for step size calculation

Simulink now uses an improved heuristic to calculate the Max step size and Fixed
step size when you set these parameters to auto in the Solver pane of the Model
Configuration Parameters dialog box. The heuristic uses the dynamics of a model in a
better way to calculate these parameters. For more information, see Max step size.

Step size details in solver information tooltip

When you set Max step size and Fixed step size to auto in the Solver pane of the
Model Configuration Parameters dialog box, you can see the numerical values of these
settings in the solver information tooltip. Previously, Simulink displayed this information
as a warning message. For more information, see Solver Overview.

Solver information in model after simulation

Starting in R2015a, after a model compiles, the right hand corner of the status bar
displays the solver used to compile a model. Previously, Simulink reverted to the
configuration setting after a simulation completed. For more information, see Solver
Overview.
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Component-Based Modeling

Consistent Data Support for Testing Components: Load input and log data
of a component from buses and all data types

Logging states and root outports now supports full logging capabilities in Normal and
Accelerator (including Model Reference Accelerator) simulation modes. State and root
outport logging in R2015a:

Supports all data types, including:

* Bus data (virtual and nonvirtual buses and arrays of buses)
*  Enumerated data
Fixed-point data

Logs states and outports based on their rates

Simulink supports Dataset objects for root inport data import, which eliminates the
need to specify multiple inputs using a comma-separated list.

Model Reference Conversion Advisor enhancements

In R2015a, the Model Reference Conversion Advisor make the conversion of a subsystem
to a referenced model easier than in previous releases.

You can have the advisor compare the results of simulating the top model for
the referenced model to the results of simulating the baseline model that has the
subsystem. In the Check conversion input parameters check, select Check
simulation results after conversion.

You can specify the following for the comparison of the simulations:

Stop time fo